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C – Commonly                    

O - Oriented 

M - Machine  

P - Particularly  

U - Used 

T - for Trade  

E - Education  

R - and Research 

Today’s world is an information-rich world and it has become a 

necessity for everyone to know about computers. A computer is an 

electronic data processing device, which accepts and stores 

data input, processes the data input, and generates the output 

in a required format.  

 

The word computer is 

derived from the word 

compute.  

Compute means to 

calculate. The computer 

was originally defined 

as a super fast 

calculator.  
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To know about the working of a computer, first need to understand 

various terms such as Data, Processing and Information. First of all, 

lets start with basic terms:- 

1. Data : Data is a collection of basic facts and figure without any 

sequence. This data is also called as raw data. When the data is collected 

as facts and figures, there is no meaning to it, at that time, for example, 

name of people, names of employees etc. 

2. Processing : Processing is the set of instructions given by the user to 

the related data that was collected earlier to output meaningful 

information. The computer does the required processing by making the 

necessary calculations, comparisons and decisions. 

3. Information : Information is the end point or the final output of any 

processed work. This meaningful output data is called information. 

4. Program: The set of instructions given to the computer to perform 

various operations is called as the computer program. 
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COMPONANTS OF COMPUTER 

All types of computers follow the same basic logical structure and 

perform the following five basic operations for converting raw input data 

into information useful to their users. 

 

Input Unit- This unit contains devices with the help of which we enter 
data into the computer. This unit creates a link between the user and the 
computer. The input devices translate the information into a form 
understandable by the computer. 

CPU (Central Processing Unit)- CPU is considered as the brain of the 
computer. CPU performs all types of data processing operations. It stores 
data, intermediate results, and instructions (program). It controls the 
operation of all parts of the computer. 

CPU itself has the following three components: 
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 ALU (Arithmetic Logic Unit)- This unit consists of two 
subsections namely, 

1. Arithmetic Section 
2. Logic Section 

Arithmetic Section- Function of arithmetic section is to perform 
arithmetic operations like addition, subtraction, multiplication, and 
division. All complex operations are done by making repetitive use of the 
above operations. 

Logic Section- Function of logic section is to perform logic operations 
such as comparing, selecting, matching, and merging of data. 

 Memory Unit- This unit can store instructions, data, and 
intermediate results. This unit supplies information to other units 
of the computer when needed. It is also known as internal storage 
unit or the main memory or the primary storage or Random 
Access Memory (RAM). Its size affects speed, power, and 
capability. Primary memory and secondary memory are two 
types of memories in the computer. Functions of the memory unit 
are − 

 It stores all the data and the instructions required for processing. 

 It stores intermediate results of processing. 

 It stores the final results of processing before these results are 
released to an output device. 

 All inputs and outputs are transmitted through the main memory. 

 
 Control Unit- This unit controls the operations of all parts of the 

computer but does not carry out any actual data processing 
operations. 

Functions of this unit are − 
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 It is responsible for controlling the transfer of data and 
instructions among other units of a computer. 

 It manages and coordinates all the units of the computer. 
 It obtains the instructions from the memory, interprets them, and 

directs the operation of the computer. 
 It communicates with Input/Output devices for transfer of data or 

results from storage. 
 It does not process or store data. 

Output Unit- The output unit consists of devices with the help of which 
we get the information from the computer. This unit is a link between the 
computer and the users. Output devices translate the computer's output 
into a form understandable by the users. 

 

Advantages of Computers 

1. High Speed 

 Computer is a very fast device. 

 It is capable of performing calculation of very large amount of 

data. 

 The computer has units of speed in microsecond, nanosecond, and 

even the Pico second. 

 It can perform millions of calculations in a few seconds as 

compared to man who will spend many months to perform the 

same task. 

 

2. Accuracy 

 In addition to being very fast, computers are very accurate. 

 The calculations are 100% error free. 

 Computers perform all jobs with 100% accuracy provided that the 
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input is correct. Storage Capability 

 

3. Memory is a very important characteristic of computers. 

 A computer has much more storage capacity than human beings. 

 It can store large amount of data. 

 It can store any type of data such as images, videos, text, audio, 

etc. 

 

4. Diligence 

 Unlike human beings, a computer is free from monotony, 

tiredness, and lack of concentration. 

 It can work continuously without any error and boredom. 

 It can perform repeated tasks with the same speed and accuracy. 

 

5. Versatility 

 A computer is a very versatile machine. 

 A computer is very flexible in performing the jobs to be done. 

 This machine can be used to solve the problems related to various 

fields. 

 At one instance, it may be solving a complex scientific problem 

and the very next moment it may be playing a card game. 

 

6. Reliability 

 A computer is a reliable machine. 

 Modern electronic components have long lives. 

 Computers are designed to make maintenance easy. 
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7. Automation 

 Computer is an automatic machine. 

 Automation is the ability to perform a given task automatically. 

Once the computer receives a program i.e., the program is stored 

in the computer memory, then the program and instruction can 

control the program execution without human interaction. 

 

8. Reduction in Paper Work and Cost 

 The use of computers for data processing in an organization leads 

to reduction in paper work and results in speeding up the process. 

 As data in electronic files can be retrieved as and when required, 

the problem of maintenance of large number of paper files gets 

reduced. 

 

Computer Applications. 

1. Banking and Financial company : Computers are used in bank 

for electronic money transfer, voucher, ledger, bank sheet, etc. 

different systems are used in Financial Company such as ATM 

(Automatic Teller Machine), EFTS (Electronic Fund Transfer 

System) etc which is computer based systems for customer 

services provided by banks. 

2. Education  : The computer helps in providing a lot of facilities in 

the education system.  The computer provides a tool in the 

education system known as CBE (Computer Based Education).  

CBE involves control, delivery, and evaluation of learning.  

Computer education is rapidly increasing  the graph of number of 

computer students.  It is used to prepare a database about 

performance of a student and analysis is carried out on this basis. 
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3. Healthcare : Computers have become an important part in 

hospitals, labs, and dispensaries. They are being used in hospitals 

to keep the record of patients and medicines. It is also used in 

scanning and diagnosing different diseases. ECG, EEG, ultrasounds 

and CT scans, etc. are also done by computerized machines. 

4. Military  : Computers are largely used in defence. Modern tanks, 

missiles, weapons, etc. Military also employs computerized 

control systems. Some military areas where a computer has been 

used are:   

• Missile Control   

• Military Communication 

• Military Operation and Planning 

• Smart Weapons 

5. Communication  : Communication is a way to convey a message, 

an idea, a picture, or speech that is received and understood 

clearly and correctly by the person for whom it is meant. Some 

main areas in this category are:  

• E-mail 

• Chatting   

• Usenet  

• FTP  

• Telnet  

• Video-conferencing 
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6. Government : Computers play an important role in government 

services. Some major fields in this category are:   

• Budgets   

• Sales tax department   

• Income tax department   

• Computation of male/female ratio 

• Computerization of voters lists   

• Computerization of PAN card 

• Weather forecasting 

EVOLUTION OF COMPUTER 

ABACUS- The abacus is one of the earliest known computation devices. It 

is a tool that helped in calculating answers of arithmetic problems. It is 

simply a wooden rack holding parallel wires on which beads are strung. 

Calculations are done by manipulating the beads. The abacus was 

developed in China about 5000 years ago. The abacus was so successful 

that its use spread from China to many other countries. 
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Pascal’s calculator called ‘Pascaline’- In the year 1642, Blaise Pascal a 

French scientist invented an adding machine called Pascal’s calculator. 

Though these machines were early forerunners to computer engineering, 

the calculator failed to be a great commercial success. 

 

Analytical engine or difference engine- Charles Babbage a British 

mathematician at Cambridge University invented the first analytical 

engine or difference engine. This machine could be programmed by 

instructions coded on punch cards and had mechanical memory to store 

the results. For his contributions in this field Charles Babbage is known as 

‘the father of modern digital computer. 
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 ENIAC (Electronic Numeric Integrator and Calculator) –In 1944 John 

Mauchley and J. Presper proposed an electronic digital computer called 

ENIAC, and completed it in 1946 which is regarded as first successful 

general digital computer. 

 

  

 

 

EDVAC(Electronic Discrete Variable Automatic Computer) – In the 

mid 1940’s Dr. John von Neumann designed the Electronic Discrete 

Variable Automatic Computer with a memory to store both program and 

data. This was the first machine which used the stored program concept. 

It had five distinct units - arithmetic, central control, memory, input and 

output. The key element was the central control. All the functions of the 

computer were co-ordinate through this single source, the central control. 

The programming of the computers was done in machine language. 
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UNIVAC 1 – Remington Rand designed this computer specifically for 

business data processing applications. The Universal Automatic Computer 

was the first general purpose commercially available computer. 
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EDSAC( Electronic delay storage automatic computer)- Ist computer 

capable of storing instructions and data in memory. 

 

  

GENERATION OF COMPUTER 

First Generation Computers - The period of first generation was from 

1946-1959. The computers of first generation used vacuum tubes as the 

basic components for memory and circuitry for CPU (Central Processing 

Unit). These tubes, like electric bulbs, produced a lot of heat and the 

installations used to fuse frequently. Therefore, they were very expensive 

and only large organizations were able to afford it. 

In this generation, mainly batch processing operating system was used. 

Punch cards, paper tape, and magnetic tape was used as input and output 

devices. The computers in this generation used machine code as the 

programming language. 
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 The main features of the first generation are: 

• Vacuum tube technology 

• Unreliable 

• Supported machine language only 

• Very costly 

• Generated a lot of heat 

• Slow input and output devices 

• Huge size 

• Need of AC 

• Non-portable 

• Consumed a lot of electricity 

Some computers of this generation were: 

• ENIAC 
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• EDVAC 

• UNIVAC 

• IBM-701 

• IBM-650 

 

Second Generation Computers - The period of second generation was 

from 1959-1965. In this generation, transistors were used that were 

cheaper, consumed less power, more compact in size, more reliable and 

faster than the first generation machines made of vacuum tubes. In this 

generation, magnetic cores were used as the primary memory and 

magnetic tape and magnetic disks as secondary storage devices. In this 

generation, assembly language and high-level programming languages 

like FORTRAN, COBOL were used. The computers used batch processing 

and multiprogramming operating system. 
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The main features of second generation are: 

• Use of transistors 

• Reliable in comparison to first generation computers 

• Smaller size as compared to first generation computers 

• Generated less heat as compared to first generation computers 

• Consumed less electricity as compared to first generation 

computers 

• Faster than first generation computers 

• Still very costly 

• AC required 

• Supported machine and assembly languages 

Some computers of this generation were: 

• IBM 1620 

• IBM 7094 

• CDC 1604 

• CDC 3600 

• UNIVAC 1108 
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Third Generation Computers - The period of third generation was from 

1965-1971. The computers of third generation used Integrated Circuits 

(ICs) in place of transistors. A single IC has many transistors, resistors, 

and capacitors along with the associated circuitry. The IC was invented by 

Jack Kilby. This development made computers smaller in size, reliable, 

and efficient. In this generation remote processing, time-sharing, multi-

programming operating system were used. High-level languages 

(FORTRAN-II TO IV, COBOL, PASCAL PL/1, BASIC, ALGOL-68 etc.) were 

used during this generation. 

 

The main features of third generation are: 

 IC used 

 More reliable in comparison to previous two generations 

 Smaller size 

 Generated less heat 

 Faster 

 Lesser maintenance 
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 Costly 

 AC required 

 Consumed lesser electricity 

 Supported high-level language 

Some computers of this generation were: 

 IBM-360 series 

 Honeywell-6000 series 

 PDP (Personal Data Processor) 

 IBM-370/168 

 TDC-316 

Fourth Generation Computers 

The period of fourth generation was from 1971-1980. Computers of 

fourth generation used Very Large Scale Integrated (VLSI) circuits. VLSI 

circuits having about 5000 transistors and  other circuit elements with 

their associated circuits on a single chip made it possible to have 

microcomputers of fourth generation. 

Fourth generation computers became more powerful, compact, reliable, 

and affordable. As a result, it gave rise to Personal Computer (PC) 

revolution. In this generation, time sharing, real time networks, 

distributed operating system were used. All the high-level languages like 

C, C++, DBASE etc., were used in this generation. 
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The main features of fourth generation are: 

 VLSI technology used 

 Very cheap 

 Portable and reliable 

 Use of PCs 

 Very small size 

 Pipeline processing 

 No AC required 

 Concept of internet was introduced 

 Great developments in the fields of networks 

 Computers became easily available 

Some computers of this generation were: 
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 DEC 10 

 STAR 1000 

 PDP 11 

 CRAY-1(Super Computer) 

 CRAY-X-MP(Super Computer) 

Fifth Generation Computers 

The period of fifth generation is 1980-till date. In the fifth generation, 

VLSI technology became ULSI (Ultra Large Scale Integration) technology, 

resulting in the production of microprocessor chips having ten million 

electronic components. This generation is based on parallel processing 

hardware and AI (Artificial Intelligence)software. AI is an emerging 

branch in computer science, which interprets the means and method of 

making computers think like human beings. All the high-level languages 

like C and C++, Java, .Net etc., are used in this generation. 

 

AI includes: 

 Robotics 
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 Neural Networks 

 Game Playing 

 Development of expert systems to make decisions in real-life 

situations 

 Natural language understanding and generation 

The main features of fifth generation are: 

 ULSI technology 

 Development of true artificial intelligence 

 Development of Natural language processing 

 Advancement in Parallel Processing 

 Advancement in Superconductor technology 

 More user-friendly interfaces with multimedia features 

 Availability of very powerful and compact computers at cheaper 

rates 

Some computer types of this generation are: 

 Desktop 

 Laptop 

 NoteBook 

 UltraBook 

 ChromeBook 
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TYPES OF COMPUTER 

There are three major categories based on which computers can be 

classified. These are: 

1. Based on Size 

2. Based on Purpose 

3. Based on Types 

Types of Computer-Based on Types 

The three types of computers along with their functions are given below: 

• Analog Computer – An analog computer one that uses the 

continuously changeable aspects of physical phenomena to model the 

problem being solved. These phenomena may be such as electrical, 

mechanical, or hydraulic quantities and they are extremely complex to be 

used. Such computers are mostly used for scientific and industrial 

applications. Examples of Analog computers include Thermometer, 

Operational Amplifiers, Electric Integrators, etc. 

• Digital Computer – Such computers are capable of solving 

problems in discrete format. It only operates on data entered in binary 

language and can perform the dynamic function of managing large 

amounts of data and regulating the operations of the machine, Examples 

of Digital computers are Desktop, Laptop, Mobile Phones, etc. 

• Hybrid Computer – Computers that exhibit features of both 

Analog and Digital computers are called Hybrid Computers. The logical 

operations are solved by the digital aspects and the differential equations 
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are solved using the analog features. Few important examples of Hybrid 

Computers include Space Flights, Food processing Plants, etc.  

Types of Computers – Based on Size 

Described below are the four types of Computers based on their sizes 

along with their functions: 

• Micro Computers – A relatively inexpensive and small computer 

comprising a microprocessor and a Central Processing Unit (CPU) is 

called a Microcomputer. Such computers are made with minimal circuitry 

mounting over a single circuit board. Examples include Desktop, Laptop, 

etc. 

• Mini Computer – Developed in the mid-1960s, Mini computers 

are comparatively smaller than mainframe computers. They were 

developed keeping in consideration human interaction, control 

instrumentation and were cost-effective. For example Smartphones, 

iPads, etc. 

• Mainframe Computer – Computers used by large Organisations 

to manage bulk data are called Mainframe computers. Main functions of 

such type include managing customer statistics, census and other heavy 

data in a single device. For example, the system used at Trading 

companies. 

• Super Computer – Supercomputers are the biggest and fastest 

computers. They are designed to process huge amount of data. A 

supercomputer can process trillions of instructions in a second. It has 

thousands of interconnected processors.  
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Supercomputers are particularly used in scientific and engineering 

applications such as weather forecasting, scientific simulations, Quantum 

Mechanics, Climate research and nuclear energy research. 

 Param Shivay, the India’s first supercomputer assembled 

indigenously, was installed in IIT (BHU), followed by Param Shakti 

and Param Brahma at IIT-Kharagpur and IISER, Pune, 

respectively. Bhatkar is best known as the architect of India's 

national initiative in supercomputing where he led the 

development of Param supercomputers. He developed the first 

Indian supercomputer, the PARAM 8000, in 1991 and later the 

PARAM 10000 in 1998. 

 

 Vijay Pandurang Bhatkar, a technocrat is considered the father 

of the Indian Supercomputer. 

 

 The CDC 6600, released in 1964, is generally considered the 

first supercomputer, designed by Seymour Cray who is 

considered the father of Super Computer. 

 Arm-powered Fugaku, in Kobe, Japan, is the the world's 

fastest supercomputer as of November 2020. 

 

Types of Computer – By Purpose 

On the basis of purpose, there are just two variety of computers. Those 

two varieties have been discussed in detail below: 

• General Purpose – Based on General Purpose, there are these 

following functions which a device is expected to perform: 



Contact- +917006208436© Copyright Mail id - jkexamcracker@gmail.comJK EXAM CRACKER - Paving path to success....

FUNDAMENTALS OF COMPUTER                              

 

25 

1. Basic Input/Output functions 

2. Calculations 

3. Data Saving on a smaller scale 

4. General performing activities 

These may include basic calculators, laptops, desktop computers, mobile 

phones, etc., which can help people with their basic necessary functions 

are included in the General Purpose computer type. 

• Special Purpose – When a computer is designed specifically to 

perform a certain function, such type of computers are known as Special 

Purpose computer. These types may include: 

1. Thermometers to test temperature 

2. Generators to manage electricity 

3. Devices used for analysing Climate Change 

4. Large computers for IT Companies 

5. Machines used at Manufacturing Units and the list goes on and on 
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COMPUTER HARDWARE                          

Abbreviated as HW, hardware is best described as any physical component of a computer system that 
contains a circuit board, ICs, or other electronics. A perfect example of hardware is the screen on which 
you are viewing this page. Whether it be a monitor, tablet, or Smartphone, it is hardware. 

External hardware  

Below is a list of external hardware or hardware found outside a computer. 

 Flat-panel, monitor, and LCD 

 Gamepad 

 Joystick 

 Keyboard 

 Microphone 

 Mouse 

 Printer 

 Projector 

 Scanner 

 Speakers 

 USB thumb drive 

Internal hardware  

Below is a list of internal hardware or hardware found inside a computer. 

1. CPU (central processing unit). 
2. Drive (e.g., Blu-ray, CD-ROM, DVD, floppy drive, hard drive, and SSD). 
3. Fan (heat sink) 
4. Modem 
5. Motherboard 
6. Network card 
7. Power supply 
8. RAM 
9. Sound card 
10. Video card 
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INPUT DEVICES- An input device is a piece of hardware used to provide data to a computer used for 
interaction and control.  It allows input of raw data to the computer for processing. 

Here’s a list of some input devices used in computers and other computing devices:  

KEYBOARD- A keyboard is a typewriter-style device, which uses an arrangement of buttons or keys, to act 
as mechanical levers or electronic switches. Most of the commonly available personal computers have a 
keyboard, popularly known as Qwerty. Keyboards are of two sizes 84 keys or 101/102 keys, but now 
keyboards with 104 keys or 108 keys are also available for Windows and Internet. 

Types of keyboards: There can be different types of keyboards based on the region and language used. 
Some of the common types of keyboards are as follows: 

i) QWERTY Keyboard: It is the most commonly used keyboard with computers in modern times. It is 
named after the first six letters of the top row of buttons and is even popular in countries that do not use 
Latin-based alphabet. It is so popular that some people think that it is the only type of keyboard to use 
with computers as an input device. 
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ii) AZERTY Keyboard: It is considered the standard French keyboard. It is developed in France as an 
alternative layout to the QWERTY layout and is mainly used in France and other European countries. Some 
countries have manufactured their own versions of AZERTY. 

 

iii) DVORAK Keyboard: This type of keyboard layout was developed to increase the typing speed by 
reducing the finger movement while typing. The most frequently used letters are kept in a home row to 
improve typing. 

 

TYPES OF KEYS ON KEYBOARD 

Typing (alphanumeric) keys- These keys include the same letter, number, punctuation, and symbol keys 
found on a traditional typewriter.i.e; A-Z.0-9. 

Modifier / Combination keys-A Modifier key is a special key (or combination) on a computer keyboard 
that temporarily modifies the normal action of another key when pressed together. By themselves, 
modifier keys usually do nothing; that is, pressing any of the Shift, Alt, or Ctrl keys alone does not 
(generally) trigger any action from the computer. 

Function keys- The function keys are used to perform specific tasks. They are labeled as F1, F2, F3, and so 
on, up to F12. The functionality of these keys differs from program to program. 
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Toggle keys- 'Caps lock' and 'Num lock' keys are called as Toggle Keys because when pressed, they change 
their status from one state to another 

Control keys- These keys provide cursor and screen control. It includes four directional arrow keys. Control 
keys also include Home, End, Insert, Delete, Page Up, Page Down, Control(Ctrl), Alternate(Alt), Escape(Esc). 

Special Purpose Keys- Keyboard also contains some special purpose keys such as Enter, Shift, Caps Lock, 
Num Lock, Space bar, Tab, and Print Screen. 

 Windows key is a four pane key that helps you open any program and applications 

 ESC Key is used to interrupt or cancel the current process 

 F1 through F12 Keys are the function keys that has various uses 

 Tab Key helps to begin a line of text 

 Caps Lock Key enables or disables the letter in uppercase 

 Shift Key helps a user to type a single uppercase letter 

 Ctrl Key is used in keyboard shortcut key 

 Fn Key is used for performing special functions like brightness, contrast, switching 

 Spacebar key is used for creating empty space to separate words 

 Arrows Key with up, down, left and right buttons 

 Backspace key is similar to delete key for removing texts in a word 

 Delete key is used to remove text, file or other objects from system 

 Enter key is used to send the cursor to next line 

 Insert key toggles how text is inserted 

 Break key enables the user to break a computer from pause or other halted state 

 Prt Sc key helps you to take screenshot on your monitor 

 Home key returns to beginning of line, document, page or screen 
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 Page up key helps to move up one page which is currently viewed 

 Page down key helps you move down the currently viewed page 

 End key moves the cursor to end of line, document or screen 

 Num lock key enables and disables the numeric keypad. 

Pointing Devices: 

An input device used to control a pointer on the screen is called a pointing device. A pointer is a small 
symbol that appears on the screen in a graphical user interface. Different shapes of a pointer are available. 

1. Mouse : Mouse is a cursor-control device . It is a pointing and drop device. It’s size is good 
enough to fit the palm. It has a palm size box with a round ball at its base .It senses the 
movement of mouse and sends corresponding signals to CPU on pressing of the buttons. There 
are two buttons that provide the left click and the right click. A scroll bar is present in the mid 
.Mouse is only used to control the position of cursor on screen. The first computer mouse was 
invented by DouglasEngelbart. 

Different types of a mouse are as follows: 

Mechanical mouse- Mechanical mouse encloses a rubber or metal ball in it. The movement of the cursor 
depends on the movement of the ball. This mouse is normally used on a mouse pad. A mouse pad is a 
small pad made of rubber or foam to provide easy movement for the mouse. It also protects the mouse 
from dust and dirt. 

 

Optical Mouse-Optical mouse contains no ball inside it. It uses a device that emits light to detect the 
mouse movement. Optical sensor or laser is used in these types of mouse.  Furthermore,  It is more costly 
than a mechanical mouse. 

 

Wireless Mouse-A wireless or cordless mouse is a type of mouse that does not require a wire to work. It 
transmits data using wireless technology like radio waves or infrared light waves. 
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The five action that you can perform with a mouse are the 

 POINTING- To locate any object on screen. 

 CLICKING- To select an item on screen. 

 DOUBLE CLICKING- To open a program or document. 

 RIGHT CLICKING- Displays list of commands on screen. 

 DRAGGING- To move an item on the screen. 
 

2. Trackball- A trackball can also be used as an alternative to a mouse. This device also has 
buttons similar to those on a mouse. It holds a large moving ball on the top. The body of the 
trackball is not moved. The ball is rolled with fingers. The position of the cursor on the screen is 
controlled by rotating the ball. 

The main benefit of the trackball over a mouse is that it takes less space to move. The trackball is 
often included in laptop computers.  The standard desktop computer also uses a trackball operated 
as a separate input device. It is used in CAD, CAM, workstations, Large trackballs are sometimes seen 
on computerized special-purpose workstations, such as the radar consoles in an air traffic control 
room, or sonar equipment on a ship or submarine. 

 

3. Touchpad/ Trackpad- A touchpad is a small, plane surface over which the user moves his 
finger. The user controls the movement of the cursor on the screen by moving his fingers on 
the touchpad. It is also known as a trackpad. 
A touchpad also has one or more buttons near it.  These button work like mouse buttons. 
Touchpads are commonly used with notebook computers. 
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4. Graphics Tablet- A graphics tablet consists of a flat pad on which the user draws with a special 
pen called a stylus. The image is created on the screen as the user draws on the pad. A designer 
can produce very accurate drawings using a graphics tablet. It is also called a digitizer. 

 

5. Touch screen- The touch screen is a video display screen that receives input from the touch of a 
finger. The screen is covered with a plastic layer. There are undetectable beams of infrared light 
at the back of the screen. In order to enter data, the user touches icons or menus on the 
screen. Most touch screen computer use sensors to detect the touch of a finger. 

 
 

6. Light Pen- A light pen is a hand-held pen-like device. It is light- sensitive stylus. Light pen is 
connected by a wire to the computer. It has a device at the tip that emits light. The pen sends 
information to the computer when a user touches the pen on certain areas of a specially 
designed screen. A light pen I usually used by engineers, graphics designers and illustrators. 

A light pen detects changes in brightness of nearby screen pixels when scanned by cathode-ray tube 
electron beam and communicates the timing of this event to the computer. Since a CRT scans the entire 
screen one pixel at a time, the computer can keep track of the expected time of scanning various locations 
on screen by the beam and infer the pen's position from the latest timestamp. 

 

 
7. Joystick- A joystick consists of a base and a stick. The stick can be moved in several directions to 

shift an object anywhere on the computer screen. A joystick can perform a similar function to a 
mouse or trackball. It is often considered less comfortable and efficient. The most common use 
of a joystick is for playing computer games. 
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A joystick, also known as the control column, is the principal control device in the cockpit of many 
civilian and military aircraft, either as a centre stick or side-stick. It often has supplementary switches 
to control various aspects of the aircraft's flight. 

Joysticks are often used to control video games, and usually have one or more push-buttons whose 
state can also be read by the computer. A popular variation of the joystick used on modern video 
game consoles is the analog stick. Joysticks are also used for controlling machines such as cranes, 
trucks, underwater unmanned vehicles, wheelchairs, surveillance cameras, and zero turning radius 
lawn mowers. Miniature finger-operated joysticks have been adopted as input devices for smaller 
electronic equipment such as mobile phones. 

 

 
8. Stylus- The stylus is similar to a ballpoint pen. It uses pressure to write text and draw lines. It 

was also called a pen. A stylus is used in graphical applications. Architects, artists, and designers 
use it to create drawings and sketches. 
 

 

 

Scanner: Scanner is an input device, which works on a similar principle of a photocopy machine. It is used 
when some information is available on a paper and it is to be transferred to the hard disc of the computer 
for further manipulation. 

Scanner captures images from the source which are then converted into the digital form that can be 
stored on the disc. These images can be edited before they are printed. 

The most common types of scanners are- 

1. Hand-held Scanners - They are very small which can be held in a hand. These are less expensive and less 
wide. Hence, in order to scan a single page image, multiple passes are required. But their handiness is a 
major advantage of handheld scanner. 
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2. Flatbed Scanners-  They are large and more expensive scanners that creates higher quality images. 
These scanners have a flat surface on which the printed image to be scanned, is placed. (Similar to the way 
a page is placed on a photocopier). Flatbed scanners can scan a page in a single pass. 

3. Drum Scanners- They are are medium-size scanners with a rolling drum. The sheet is fed through the 
scanners so that the drum rolls over the entire sheer to be scanned (Just as the sheets are fed in a fax 
machine).  

Magnetic Ink Card Reader (MICR) : We see in banks, libraries etc using MICR as an input device . As large 
number of cheques are processed everyday MICR serves a very useful purpose. A special type of ink that 
contains particles of magnetic material that is machine readable, is used to read the code number and 
cheque number that are printed on the cheques in banks. This reading process is called Magnetic Ink 
Character Recognition (MICR). The main advantage of MICR is that it is highly accurate and fast in reading. 

MICR reads the characters by examining their shapes in a matrix form and the information is then passed 
`on to the computer. 

 

OMR (Optical Mark Recognition): Optical mark recognition (also called optical mark reading and OMR) is 
the process of capturing human-marked data from document forms such as surveys and test.  It uses a 
beam of light that is reflected on the paper with marks, to capture presence and absence of marks. They 
are used to read questionnaires, multiple choice examination paper in the form of lines or shaded areas. 

 

Optical Character Reader (OCR) : OCR is an input device that is used to read a printed text. The role of 
OCR is to scan the text optically character by character by converting them into a machine readable code 
and store the text on the system. The OCR is used for the preparation of electricity bills, insurance 
premium, telephone bills. 

    It is used to scan the document containing text. It is the mechanical or electronic conversion of scanned 
or photographed images of typewritten or printed text into machine encoded/computer-readable text. 
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SCR (Smart Card Readers): A small electronic device about the size of a credit card that contains electronic 
memory, and possibly an embedded integrated circuit (IC). Smart cards containing an IC are sometimes 
called Integrated Circuit Cards (ICCs). 

Smart cards are used for a variety of purposes, including: 

– Storing a patient’s medical records 

– Storing digital cash 

– Generating network IDs (similar to a token) 

To use a smart card, either to pull information from it or add data to it, you need a smart card reader, a 
small device into which you insert the smart card. 

 

Bar Code Readers : Bar Code Reader is a device used for reading bar coded data (data in form of light and 
dark lines). Bar coded data is generally used in labeling goods, numbering the books, etc .Bar Code Reader 
scans a bar code image by converting it into an alphanumeric values . This value is then fed to the 
computer to which bar code reader is connected. 

 

 A QR code (abbreviated from Quick Response code) is a type of matrix barcode (or two-
dimensional barcode) first designed in 1994 for the automotive industry in Japan. A barcode is 
a machine-readable optical label that contains information about the item to which it is 
attached. In practice, QR codes often contain data for a locator, identifier, or tracker that points 
to a website or application. A QR code uses four standardized encoding modes (numeric, 
alphanumeric, byte/binary, and kanji) to store data efficiently; extensions may also be used. 
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Biometrics- A biometric device is a security identification and authentication device. Such devices use 
automated methods of verifying or recognizing the identity of a living person based on a physiological or 
behavioral characteristic. These characteristics include fingerprints, facial images, and iris and voice 
recognition. 

 

Microphone : A microphone, is an acoustic-to-electric transducer or sensor that converts sound in air into 
an electrical signal. Microphones are used in many applications such as telephones, hearing aids, public 
address systems for concert halls and public events, motion picture production, live and recorded audio 
engineering, two-way radios, megaphones, radio and television broadcasting, and in computers for 
recording voice, speech recognition, VoIP, and for non-acoustic purposes such as ultrasonic checking or 
knock sensors. 

 

Webcam : A webcam is a video camera that feeds or streams its image in real time to or through a 
computer to computer network. When “captured” by the computer, the video stream may be saved, 
viewed or sent on to other networks via systems such as the internet, and email as an attachment. When 
sent to a remote location, the video stream may be saved, viewed or on sent there. Unlike an IP camera 
(which connects using Ethernet or Wi-Fi), a webcam is generally connected by a USB cable, or similar 
cable, or built into computer hardware, such as laptops. 

 

 

 



Contact- +917006208436© Copyright Mail id - jkexamcracker@gmail.comJK EXAM CRACKER - Paving path to success....

COMPUTER HARDWARE                          

BY TANIYA ABROL 

12 

OUTPUT DEVICES 

An output device is any piece of computer hardware equipment which converts information into 
human-readable form. It can be text, graphics, tactile, audio, and video. 

Following are some of the important output devices used in a computer. 

 Monitors 

 Graphic Plotter 

 Printer 

 Speaker. 

Monitors 

Monitors, commonly called as Visual Display Unit (VDU), are the main output device of a computer. It 
forms images from tiny dots, called pixels that are arranged in a rectangular form. The sharpness of the 
image depends upon the number of pixels. 

It can either be a monochrome display or a color display. The number of pixels displayed on a screen is 
known as Resolution. 

Dot pitch (sometimes called line pitch, stripe pitch, or phosphor pitch) is a specification for a computer 
display, computer printer, image scanner, or other pixel-based device that describes the distance, for 
example, between dots (sub-pixels) on a display screen. In the case of an RGB color display, the derived 
unit of pixel pitch is a measure of the size of a triad plus the distance between triads. 

The refresh rate (or "vertical refresh rate", "vertical scan rate", terminology originating with the cathode 
ray tubes) is the the frequency with which the image on a computer monitor or similar electronic display 
screen is refreshed, usually expressed in hertz. This is independent from frame rate, which describes how 
many images are stored or generated every second by the device driving the display. 

On cathode ray tube (CRT) displays, higher refresh rates produce less flickering, thereby reducing eye 
strain. In other technologies such as liquid-crystal displays, the refresh rate affects only how often the 
image can potentially be updated. 

RESOLUTION- The number of pixels arranged horizontally by the number of pixels arranged vertically is 
the resolution of the display. This means that the number of pixels inside the display, the better will be 
the picture quality and the clearer the picture displayed would be. 

Some of the common display resolutions found on the displays are as follows- 

 2560 x 1440 (1440p) 

 1920 x 1080 (FHD or Full HD or 1080p) 

 1600 x 900 

 1024 x 768 

 1280 x 720 (HD or 720p) 
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There are two kinds of viewing screen used for monitors. 

 Cathode-Ray Tube (CRT) 

 Flat-Panel Display 

 CRT is the technology used in traditional computer monitors and televisions. The image on a 
CRT display is created by firing electrons from the back of the tube to phosphors . ( the screen is 
covered with a fine line of phosphoric elements called phosphors) located towards the front of 
the display. Once the electrons hit the phosphors, they light up and are projected on the 
screen. The color you see on the screen is produced by a blend of red, blue, and green light, 
often referred to as RGB 
 
The CRT display is made up of small picture elements called pixels. The smaller the pixels, the 
better the image clarity or resolution. It takes more than one illuminated pixel to form a whole 
character. 
 
There are some disadvantages of CRT − 
 

 Large in Size 

 High power consumption 
 

 

 

 Flat-Panel Display Monitor : These flat panel displays overcome the disadvantages of CRT as 
they have reduced volume, weight and power requirement compared to the CRT. They come in 
different shapes and size. You can hang them on walls or wear them on your wrists. They are 
used in all modern day calculators, video games, monitors, laptop computer, graphics display 
etc as displays. 
 

 

The flat-panel display are of two main types : 

‘VDT (video display terminal) and VDU (video display unit) are alternative names for monitors.’ 
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Non-Emissive Displays : The Non-emissive displays use optical effects to convert sunlight or light from 
some other source into graphics patterns. Example is LCD (Liquid-Crystal Device) 

 Liquid Crystal Devices (LCD) monitors– It is a flat panel display that uses the light- modulating 
properties of liquid crystals. It is used in LCD televisions, aircraft cockpit displays, etc. It is thin, 
light-weight screen made up of any number of colour or  monochrome  pixels arranged in front 
of a light source. 

It is more energy-efficient, as it does not use phosphorous and can be disposed of more safely than the 
CRT monitors. 

 

 

 

Emissive Displays : The emissive displays convert electrical energy into light. Example are plasma panel 
and LED (Light-Emitting Diodes). 

 Light Emitting Diode (LED) monitors - It is an improved version of the LCD monitor. The 
technology used in both the monitors is the same except the backlighting. 
The LED monitors are lighter, thinner, and less expensive. These monitors are more reliable as 
they have a more broad dimming range. 

 Plasma monitors- It is a monitor in which each pixel on the screen is illuminated by a tiny bit of 
charges gas or plasma similar to a tiny neon light. These monitors are thinner than Cathode ray 
tube monitors and brighter than liquid crystal display monitors. 

Printers : Printer is among the most common output device, which is used to print information on paper. 
The printed form of output is referred as Hard Copy. The form of output displayed on the screen is 
referred as Soft Copy. 

 The speed of the printer is measured in Pages per Minute (PPM), Characters per second (CPS), 
Lines per minute (LPM). The faster the printing, the more expensive the printer. 

 Printer Resolution is easured in dots Per inch (DPI). 

On the basis of technology, printers are categorized into 

Impact and Non- Impact Printers. 

Impact printers create an image by using some mechanism to physically press an inked ribbon against the 
page, causing the ink to be deposited on the page in the shape desired. 

I) Dot matrix :- They are the most popular printers because of their ease of printing features. They come at 
a low cost. The dot-matrix printer uses print heads containing from 9 to 24 pins. These pins produce 

A thin-film-transistor liquid-crystal display (TFT LCD) is a variant of a liquid-crystal display (LCD) 

that uses thin-film-transistor (TFT) technology to improve image qualities such as addressability 

and contrast. A TFT LCD is an active matrix LCD, in contrast to passive matrix LCDs or simple, direct-

driven[clarification needed] LCDs with a few segments. 

 

TFT LCDs are used in appliances including television sets, computer monitors, mobile phones, 

handheld devices, video game systems, personal digital assistants, navigation systems, 

projectors,[2] and car dashboards. 
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patterns of dots on the paper to form the individual characters. Each character is printed in the form of 
pattern of Dot’s and head 

 

II)Daisy wheel Printer :- These are known as daisy wheel printers as the head lies on the wheel and Pins 
correspond to characters like petals of Daisy flower. A hammer strikes a “petal” containing a character 
against the ribbon, and the character prints on the paper. Its speed is slow typically 25-55 characters per 
second. These printers are used for word-processing in offices and offer very nice quality representation. 

Advantages 

 More reliable than DMP 

 Better quality 

 Fonts of character can be easily changed 

Disadvantages 

 Slower than DMP 

 Noisy 

 More expensive than DMP 

 

III) Line printer:-Line printers, or line-at-a-time printers, use special mechanism that can print a whole line 
at once; they can typically print the range of 1,200 to 6,000 lines per minute. Speed of line printers is 
limited by the speed of cartridge used. 
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IV) Drum printer:- A drum printer consists of a solid, cylindrical drum that has raised characters in bands 
on its surface. The number of print positions across the drum equals the number available on the page. 
This printer looks like a drum in shape that’s why it is called a drum printer. The Drum surface has a 
number of tracks. Total tracks are equal to size of paper, i.e., for a paper width of 132 characters, Drum 
will have 132 tracks. A character set is embossed on track. The different character sets available in market 
are 48 character set, 64 and 96 characters set. One rotation of drum leads to printing of one line. These 
printers print between 300 to 2000 lines per minute. Hence they have a very high speed. 

 

V) Chain printer:- A chain printer uses a chain of print characters wrapped around two pulleys. In this 
printer because chain of character sets are used hence they are called as Chain Printers. A standard 
character set may have 48, 64, 96 characters.  

 

 

Non – Impact Printers do not touch the paper when creating an image. 

I) Ink-jet printers:- Ink-jet printers are new technology non-impact character printers. They print 
characters via spraying small drops of ink onto paper. Ink-jet printers produce very high quality output 
with presentable features. They are noiseless printers and have many styles of printing modes available. 
These are also called as the coloured printers. Models of Ink-jet printers can produce multiple copies of 
printing also. One or more nozzles in the print head emit a steady stream of ink drops. Droplets of ink are 
electrically charged after leaving the nozzle. The droplets are then guided to the paper by electrically 
charged deflecting plates. 

Advantages 

 High quality printing 

 More reliable 
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Disadvantages 

 Expensive as the cost per page is high 

 Slow as compared to laser printer 

 

II) Laser printers:- They use laser lights to produce the dots needed to form the characters to be printed 
on a page. When a whole page is loaded, it will be printed. 

Advantages 

 Very high speed 

 Very high quality output 

 Good graphics quality 

 Supports many fonts and different character size 

Disadvantages 

 Expensive 

 Cannot be used to produce multiple copies of a document in a single printing 

 

III)Thermal printer:- is a digital printing process which produces a printed image by selectively heating 
coated thermo chromic paper, or thermal paper as it is commonly known, when the paper passes over the 
thermal print head. 

Thermal printers are used most commonly to create labels, safety signs, wayfinding markers, barcodes, 
shipping labels, and other heavily-used items. 
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Plotters- A plotter is a computer hardware device much like a printer that is used for printing vector 
graphics. Instead of toner, plotters use a pen, pencil, marker, or another writing tool to draw multiple, 
continuous lines onto paper rather than a series of dots like a traditional printer. Though once widely used 
for computer-aided design, these devices have more or less been phased out by wide-format printers. 
Plotters produce a hard copy of schematics and other similar applications. 

Advantages of plotters 

 Plotters can work on very large sheets of paper while maintaining high resolution. 

 They can print on a wide variety of flat materials including plywood, aluminum, sheet steel, 
cardboard, and plastic. 

 Plotters allow the same pattern to be drawn thousands of times without any image 
degradation. 

Disadvantages of plotters 

 Plotters are quite large compared to a traditional printer. 

 Plotters are also much more expensive than a traditional printer. 

 

 

Speaker : A hardware device connected to a computer’s sound card that outputs sounds generated by the 
computer. It needs a sound card connected to a CPU, that generates sound via a card. These are used for 
listening music, for being audible in seminars etc. 

Projector : A projector is an output device that can take images generated by a computer and reproduce 
them on a large, flat (usually lightly colored) surface. For example, projectors are used in meetings to help 
ensure that all participants can view the information being presented. 

COMPUTER PROCESSING DEVICES 

Processing is the core function of any computer. When a computer receives data from an input device, 
this data must first go through an intermediate stage before it is sent to an output device. Processing is 
the intermediate stage where raw data is transformed into information so that it can be outputted 
meaningfully for the user. An example of a processing device is the central processing unit (CPU), which 
is a set of electronic circuitry that processes and executes instructions. 

 CPU (CENTRAL PRECESSING UNIT) 
Think of a computer as a human body with the CPU being the brain, controlling everything the 
computer does. The CPU is the part of a computer responsible for receiving and carrying out 
computer instructions. It does this by making use of millions (or even billions) of transistors, 

The first plotter was invented in 1953 by Remington-Rand. It was used in conjunction with the 
UNIVAC computer to created technical drawings. 
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which can each be switched on or off individually. The computer system ‘s principal and the 
most critical computing device is the central processing unit. 
 
‘It is also called the computer’s heart and brain because it carries out a computer program ‘s 
instructions, as well as all computer functions.’ 
 
A computer can’t perform any of the operations without a CPU. A CPU is fabricated as a single 
integrated chip as is also known as Microprocessor. 
 
 

 

 

 

 

 

The microprocessor is subdivided into three important units, which work together in order to 
accomplish its function. The units are: 

o The control unit: It manages and supervises the operations of the processor and other components 
that are crucial in data manipulation. 

o Arithmetic and logic unit: The ALU is responsible for all arithmetic and logic operations like 
addition, multiplication, subtraction, division, and comparison logic operations. 

o Memory Unit: These are storage locations inside the processor that respond to the instructions of 
the control unit by moving relevant data around during processing. 

Instruction cycle 

The instruction cycle (also known as the fetch–decode–execute cycle, or simply the fetch-execute cycle) is 
the cycle that the central processing unit (CPU) follows from boot-up until the computer has shut down in 
order to process instructions.  

In a basic computer, each instruction cycle consists of the following phases: 

o Fetch instruction from memory. 
o Decode the instruction. 
o Read the effective address from memory. 
o Execute the instruction. 

 
 

 MOTHERBOARD 
Alternatively referred to as the mb, mainboard, mboard, mobo, mobd, backplane board, base 
board, main circuit board, planar board, system board, or a logic board on Apple computers. 
The motherboard is a printed circuit board and foundation of a computer that is the biggest 
board in a computer chassis.  

 The speed of a CPU is measured in gigahertz (GHz), which shows how many 

instructions can be performed in one second. One GHz is equal to a 100 million 

hertz.(Gigahertz refers to the CPU frequency , As a general guideline; the higher the 

frequency, the better the CPU.) 

 Number of cores: As with the processor speed, generally more cores are better. 

 The CPU was first developed during the 1970s at Intel, with the first processor, the 

4004 processor, released. 
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The functions of a computer motherboard are as follows: 

o The motherboard acts as the central backbone of a computer on which other modular parts are 
installed such as the CPU, RAM and hard disks. 

o The motherboard also acts as the platform on which various expansion slots are available to 
install other devices / interfaces. 

o The motherboard is also responsible to distribute power to the various components of the 
computer. 

o They are also used in the coordination of the various devices in the computer and maintain an 
interface among them. 

o It allocates power and allows communication to and between the CPU, RAM, and all other 
computer hardware components. 

 
Popular Manufacturers 

o Intel 
o ASUS 
o AOpen 
o ABIT 
o Biostar 
o Gigabyte 
o MSI 

 

Computer - Memory 

A memory is just like a human brain. It is used to store data and instructions. Computer memory is the 
storage space in the computer, where data is to be processed and instructions required for processing are 
stored. The memory is divided into large number of small parts called cells. Each location or cell has a 
unique address, which varies from zero to memory size minus one. For example, if the computer has 64k 
words, then this memory unit has 64 * 1024 = 65536 memory locations. The address of these locations 
varies from 0 to 65535. 

Memory is primarily of three types − 

o Cache Memory 
o Primary Memory/Main Memory 
o Secondary Memory 
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1. Cache Memory 

Cache memory is a very high speed semiconductor memory which can speed up the CPU. It acts as a buffer 
between the CPU and the main memory. It is used to hold those parts of data and program which are most 
frequently used by the CPU. The parts of data and programs are transferred from the disk to cache 
memory by the operating system, from where the CPU can access them. 

Advantages 

1. Cache memory is faster than main memory. 
2. It consumes less access time as compared to main memory. 
3. It stores the program that can be executed within a short period of time. 
4. It stores data for temporary use. 

 

Disadvantages 

1. Cache memory has limited capacity. 
2. It is very expensive. 

 
2. Primary Memory (Main Memory) 

Primary memory holds only those data and instructions on which the computer is currently working. It has 
a limited capacity and data is lost when power is switched off. It is generally made up of semiconductor 
device. These memories are not as fast as registers. The data and instruction required to be processed 
resides in the main memory. It is divided into two subcategories RAM and ROM. 

Characteristics of Main Memory 

o These are semiconductor memories. 
o It is known as the main memory. 
o Usually volatile memory. 
o Data is lost in case power is switched off. 
o It is the working memory of the computer. 
o Faster than secondary memories. 
o A computer cannot run without the primary memory. 

Types of primary Memory- 

1) RAM  2) ROM 
 

 RAM (Random Access Memory) is the internal memory of the CPU for storing data, program, 
and program result. It is a read/write memory which stores data until the machine is working. 
As soon as the machine is switched off, data is erased. 

Access time in RAM is independent of the address, that is, each storage location inside the memory is as 
easy to reach as other locations and takes the same amount of time. Data in the RAM can be accessed 
randomly but it is very expensive. 
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RAM is volatile, i.e. data stored in it is lost when we switch off the computer or if there is a power failure. 
Hence, a backup Uninterruptible Power System (UPS) is often used with computers. RAM is small, both in 
terms of its physical size and in the amount of data it can hold. 

RAM is of two types − 

o Static RAM (SRAM) 
o Dynamic RAM (DRAM) 

Static RAM (SRAM)- The word static indicates that the memory retains its contents as long as power is 
being supplied. However, data is lost when the power gets down due to volatile nature. SRAM chips use a 
matrix of 6-transistors and no capacitors. Transistors do not require power to prevent leakage, so SRAM 
need not be refreshed on a regular basis. 

There is extra space in the matrix, hence SRAM uses more chips than DRAM for the same amount of 
storage space, making the manufacturing costs higher. SRAM is thus used as cache memory and has very 
fast access. 

Characteristic of Static RAM 

o Long life 
o No need to refresh 
o Faster 
o Used as cache memory 
o Large size 
o Expensive 
o High power consumption 

Dynamic RAM (DRAM) 

DRAM, unlike SRAM, must be continually refreshed in order to maintain the data. This is done by placing 
the memory on a refresh circuit that rewrites the data several hundred times per second. DRAM is used 
for most system memory as it is cheap and small. All DRAMs are made up of memory cells, which are 
composed of one capacitor and one transistor. 

Characteristics of Dynamic RAM 

o Short data lifetime 
o Needs to be refreshed continuously 
o Slower as compared to SRAM 
o Used as RAM 
o Smaller in size 
o Less expensive 
o Less power consumption 
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ROM stands for Read Only Memory. - The memory from which we can only read but cannot write on it. 
This type of memory is non-volatile. The information is stored permanently in such memories during 
manufacture. A ROM stores such instructions that are required to start a computer. This operation is 
referred to as bootstrap. ROM chips are not only used in the computer but also in other electronic items 
like washing machine and microwave oven. 

o PROM (Programmable Read Only Memory) 

PROM is read-only memory that can be modified only once by a user. The user buys a blank PROM and 
enters the desired contents using a PROM program. Inside the PROM chip, there are small fuses which are 
burnt open during programming. It can be programmed only once and is not erasable. 

o EPROM (Erasable and Programmable Read Only Memory) 

EPROM can be erased by exposing it to ultra-violet light for a duration of up to 40 minutes. Usually, an 
EPROM eraser achieves this function. During programming, an electrical charge is trapped in an insulated 
gate region. The charge is retained for more than 10 years because the charge has no leakage path. For 
erasing this charge, ultra-violet light is passed through a quartz crystal window (lid). This exposure to ultra-
violet light dissipates the charge. During normal use, the quartz lid is sealed with a sticker. 

o EEPROM (Electrically Erasable and Programmable Read Only Memory) 

EEPROM is programmed and erased electrically. It can be erased and reprogrammed about ten thousand 
times. Both erasing and programming take about 4 to 10 ms (millisecond). In EEPROM, any location can be 
selectively erased and programmed. EEPROMs can be erased one byte at a time, rather than erasing the 
entire chip. Hence, the process of reprogramming is flexible but slow. 

Advantages of ROM 

o Non-volatile in nature 
o Cannot be accidentally changed 
o Cheaper than RAMs 
o Easy to test 
o More reliable than RAMs 
o Static and do not require refreshing 
o Contents are always known and can be verified 

 

 

 

 

 

 

 

o Flash memory is a type of erasable read-only memory (EEPROM) that clears and rewrites data in chunks for 

fast, energy-efficient access and rewriting. Flash memory, or flash storage, is non-volatile, which means it 

remains viable even without an active power source 

o A buffer contains data that is stored for a short amount of time, typically in the computer's memory (RAM). 

The purpose of a buffer is to hold data right before it is used. 

o Virtual memory is a feature of an operating system that enables a computer to be able to compensate 

shortages of physical memory by transferring pages of data from random access memory to disk storage. This 

process is done temporarily and is designed to work as a combination of RAM and space on the hard disk. This 

means that when RAM runs low, virtual memory can move data from it to a space called a paging file. This 

process allows for RAM to be freed up so that a computer can complete the task 
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Secondary Memory 

This type of memory is also known as external memory or non-volatile. It is slower than the main memory. 
These are used for storing data/information permanently. CPU directly does not access these memories, 
instead they are accessed via input-output routines. The contents of secondary memories are first 
transferred to the main memory, and then the CPU can access it. For example, disk, CD-ROM, DVD, etc. 

Characteristics of Secondary Memory 

o These are magnetic and optical memories. 
o It is known as the backup memory. 
o It is a non-volatile memory. 
o Data is permanently stored even if power is switched off. 
o It is used for storage of data in a computer. 
o Computer may run without the secondary memory. 
o Slower than primary memories. 

 

STORAGE DEVICES/MEDIA 

Magnetic tape - Magnetic tape is a medium for magnetic recording, made of a thin, magnetizable coating 
on a long, narrow strip of plastic film. It was developed in Germany in 1928, based on magnetic wire 
recording. Devices that record and playback audio and video using magnetic tape are tape recorders and 
video tape recorders respectively. A device that stores computer data on magnetic tape is known as a tape 
drive. 

Magnetic Disk-  Magnetic Disk devices are- 

1) Hard Disk: 

It is a rigid magnetic disc that is used to store data. It permanently stores data and is located within a drive 
unit. 

 

The hard disk is also known as a hard drive. It is a rigid magnetic disc that stores data permanently, as it is 
a non-volatile storage device. The hard disk is located within a drive unit on the computer's motherboard 
and comprises one or more platters packed in an air-sealed casing. The data is written on the platters by 
moving a magnetic head over the platters as they spin. The data stored on a computer's hard drive 
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generally includes the operating system, installed software, and the user's files and programs, including 
pictures, music, videos, text documents, etc. 

Components of Hard Drive: 

The main components of a hard drive include a head actuator, read/write actuator arm, read/write head, 
platter, and spindle. A circuit board, which is called the disk controller or interface board, is present on the 
back of a hard drive. It allows the hard drive to communicate with the computer. 

2. Floppy Disk: Floppy disks are disks of plastic coated in magnetic material and enclosed in a hard plastic 
case. The read/write area is covered by a sliding metal flap. 

Although, they used to be very common, as they were a convenient way of transporting files from one 
computer to another, they not much used anymore. Floppy disks are written to and read from, through 
the use of separate floppy disk drives. The floppy diskette was first created in 1967 by IBM as an 
alternative to buying hard drives, which were extremely expensive at the time. 

Floppy disks are less popular than they have been because :- 

o They are easily damaged. 
o Have a limited storage capacity in that they can only hold 1.44MB. Photos,  

 

OPTICAL STORAGE 

In the optical storage devices, all read and write activities are performed by light. All recording information 
stores at an optical disk. As per the opinions of data scientist that compact space is most useful for huge 
data storage. Their big advantages are not more costly, light weight, and easy to transport because it is 
removable device unlike hard drive. 

In the optical storage devices, all data is saved like as patterns of dots which can be easily read with using 
of LIGHT. Laser Beam is used like as “Light Source”. The data is read while bouncing laser beam on the 
surface of storage medium. Laser beam creates the all Dots while reading process, but it is used with high 
power mode to mark the surface of storage medium, and make a dot. This entire process is also called the 
“Burning” data onto Disc. 

 

Types of Optical Storage Devices 

CD-ROM- CD-ROM stands for “Compact Disc Read Only Memory”, and CD-ROM comes in the “Random 
Access” category’s devices. These types of disc can capable to store almost 800 MB of digital data. These 
data can’t discard by mistaken. 

DVD-ROM- DVD-ROM stands for “Digital Versatile Disc – Read Only Memory”, and it also comes in the 
“Random Access” category’s devices. DVD-ROM discs can store data up to 4.7 GB, but Dual Layer DVD 
device’s storage capacity is double. These types of disc are used to store ultra quality video. 
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Blue Ray- Blue Ray discs are totally replaced by DVDs, because these discs are capable to hold data up to 
25-50 GB, as well as double layer Blue Rays discs can store double data. Due to high storage capacity, Blue 
Ray discs are used to store HD (High Definition) videos. 

HD DVD- HD DVD stands for “High Density DVD”, and these devices are capable to store data up to 15 GB 
(Dual Layer HD DVDS have storage capacity double). High-Density DVD discs are also used to hold HD 
Videos. 

DVD-RAM- DVD-RAM stands for “DVD-Random Access Memory”, and it is able to Re-Write data. DVD-
RAM are available in market like as floppy-disc style case. These types of discs have storage capacity of 
data similar to DVD (up to 4.7 GB). 

DVD-RAM devices are used in several Camcorders such as “Video Recording Cameras”, and it can be used 
for data back-up and archiving. 

Recordable Optical Devices 

There are two types of discs such as “CD-R and DVD-R” and “CD-RW and DVD-RW”. 

CD-R & DVD-R- Full form of (CD-R & DVD-R) is “CD-Recordable and DVD Recordable”, and they are able to 
burn data on to them, but not easy to delete data. Users can add any type of data, but they can’t discard 
added data or re-use fully disc. 

CD-RW & DVD-RW- CD-RW & DVD-RW stands for “CD-Re Writable and DVD-Re Writable”, and they are 
capable to burn data similar (CD-R and DVD-R) onto them. Users can also delete and Re-Used data. 

Advantages of Optical Storage Devices 

 It is capable to store vast amount of data. 

 Affordable price 

 It can be recycled (Re-used). 

 It has ultra data stability. 

 Countable/uncountable storage units 

 Best Durability, Transport-ability, and archiving. 

Disadvantages of  Optical Storage Devices 

 Some traditional PCs are not able to read these disks. 

 It is getting trouble while recycling. 

Pen drive:  Pen drive is a compact secondary storage device. It is also known as a USB flash drive, thumb 
drive or a jump drive. It connects to a computer via a USB port. It is commonly used to store and transfer 
data between computers. For example, you can write a report using a computer and then copy or transfer 
it in the pen drive. Later, you can connect this pen drive to a computer to see or edit your report. You can 
also store your important documents and pictures, music, videos in the pen drive and keep it at a safe 
place. 

Pen drive does not have movable parts; it comprises an integrated circuit memory chip that stores the 
data. This chip is housed inside a plastic or aluminium casing. The data storage capacity of the pen drive 
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generally ranges from 2 GB to 128 GB. Furthermore, it is a plug and play device as you don't need 
additional drives, software, or hardware to use it. 

SD Card:  SD Card stands for Secure Digital Card. It is most often used in portable and mobile devices such 
as smart phones and digital cameras. You can remove it from your device and see the things stored in it 
using a computer with a card reader. 

There are many memory chips inside the SD card that store the data; it does not have moving parts. SD 
cards are not created equal, so they may differ from each other in terms of speed, physical sizes, and 
capacity. For example, standard SD cards, mini SD cards, and micro SD cards. 

Memory unit is the amount of data that can be stored in the storage unit. This storage capacity is 
expressed in terms of Bytes. 

The following table explains the main memory storage units − 

 

S.No. Unit & Description 

1 
Bit (Binary Digit) 

A binary digit is logical 0 and 1 representing a passive or an active state of a component in an 
electric circuit. 

2 
Nibble 

A group of 4 bits is called nibble. 

3 

Byte 

A group of 8 bits is called byte. A byte is the smallest unit, which can represent a data item or a 
character. 

4 

Word 

A computer word, like a byte, is a group of fixed number of bits processed as a unit, which 
varies from computer to computer but is fixed for each computer. 

The length of a computer word is called word-size or word length. It may be as small as 8 bits 
or may be as long as 96 bits. A computer stores the information in the form of computer 
words. 
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The following table lists some higher storage units – 

S.No. Unit & Description 

1 Kilobyte (KB) 

1 KB = 1024 Bytes 

2 
Megabyte (MB) 

1 MB = 1024 KB 

3 
GigaByte (GB) 

1 GB = 1024 MB 

4 
TeraByte (TB) 

1 TB = 1024 GB 

5 
PetaByte (PB) 

1 PB = 1024 TB 
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What is Software:  Computer software, or only software, is a kind of program that enable a user to perform 
some specific task or used to operate a computer. It directs all the peripheral devices on the computer system 
– what to do and how to perform a task. PC Software plays the role of mediator between the user and 
computer hardware. Without software, a user can’t perform any task on a digital computer.  

“A computer system can be divided into three components: the hardware, the software, and the users. Bare 
use of hardware is not easy, so to make it easy, software created. A software product development company is 
the one which develops software for the users.” 

There are two types of software − 

1. System Software 
2. Application Software 

System Software- The software that helps to activate the computer system and  controls the system hardware 
and interacts with application software. These software products comprise of programs which interact with 
the hardware at a very basic level. System software serves as the interface between the hardware and the end 
users.  

VARIOUS SYSTEM SOFTWARE ARE- 

1. Operating System (OS) : Software that helps to activate the computer system and provide common 
platform to operate the computer system by the user is called OS. It is the first layer of software 
loaded into computer memory on the time of booting (Starts Up).  

Operating System plays an important role in loading programs from disk into memory, displaying message, 
translating program and in outputting the results. The main function of OS is to manage the disk access, files 
process etc. Other software is loaded on the environment of OS. Windows Xp, Linux, MS-DOS etc are popular 
OS. 

2. Device Drivers:  System software helps to activate and recognize the computer hardware devices. 
To activate and recognize the hardware devices computer system requires special software called 
device drivers. To work with all devices, we need this software. For example to work with Modem, 
Printers we have to install their driver software then only these devices will work. 

3. Languages Translator: Translator program is a computer program that converts then programming 
instructions written in human convenient form into machine codes. Computer are digital devices. It 
can work only on the digits which are 0 to 1. All types of commands, data and instructions required 
to be converted into machine code which is the combination of 0's and 1's. Different types of 
programming languages accept the data and instructions on natural language like English. But 
computer can not process such data and instructions on natural language. So they should be 
translated into machine code. To convert such natural language. So they should be translated into 
machine code. 

Introduction to Computer Languages 

‘Programming Language is a set of rules called syntax which user has to follow, to instruct the computer 
what operation are to be performed.’ 

Computer language are classified into two categories: 

1. Low-Level Languages 
• Machine level languages 
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• Assembly languages 
2. High-Level Languages 
• General Purpose languages (Ex: BASIC, PASCAL, C) 
• Specific purpose languages (Ex: COBOL, FORTAN, C++) 

Machine Level Language 

• Machine level language is the fundamental language of a computer. 
• It is written using binary numbers i.e. 0’s and 1’s. 
• A program written in the machine level language is called Machine code. 

Assembly Level Language: 

• Assembly level language is a low-level programming language that allows a user to write 
programs using letters, words and symbols called mnemonics, instead of the binary digits 
used in machine level languages. 

• A program written in the assembly level language is called Assembly code. 

High-level Languages 

• A language designed to make programming easier through the use of familiar English words 
and symbols. 

• High-level languages used English like language, which are easier to learn and use. 
• High-level languages are machine independent. Therefore, a program written for one 
• computer can be executed on different computers with no or only slight modifications. 
• Some of the high-level languages are C, C++, JAVA, FORTRAN, QBASIC, and PASCAL. 

Assembler: 

• Assembler is system software, which translates an assembly language program into its 
machine language. 

• It recognizes the mnemonics used in the assembly level languages and substitutes the 
required machine code for each instruction. 

• Example: TASM (Turbo Assembler), MASM (Microsoft Macro Assembler) etc. 

Compilers: 

• Compiler is system software that translates high-level language (source code) into the 
machine level language (machine/object code). 

• It reads the whole program and translates the entire program at once into a series of machine 
level language instructions. 

• Once compiled, the program normally is saved automatically and can be executed directly. 
• Examples: C, C++. 

Interpreters: 

• An Interpreter reads once a statement of a high-level language program at a time, translates it 
into machine level language, and executes it immediately. 

• It continues to read, translate and execute the statements one by one until it reaches the end 
of the  program. Therefore, it is slower than a compiler. 

• The machine code produced by the interpreter is not saved and hence, to execute a 
statement again, it has to be interpreted again. 
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• Example: BASIC, PROLOG 

Linker : A linker is system software that links (combines) smaller programs to form a single program. A source 
program written in high-level languages may contain a number of modules or segments. To execute properly 
the modules are to be linked so that execution of the program is sequential. This operation is performed by 
software called as the linker. 

Loader: A loader is system software that loads machine code of a program into the system memory and 
prepares these programs for execution. Once an executable program is generated someone will have to load 
the program into the main memory of the computer so that it can be executed. This operation is performed by 
software called as the loader. 

4. Utility Software: System software that increases the performance of the computer system is utility 
software. It helps to maximize the utilization of devices. Utilities are those helpful programs that 
assist the computer by performing helpful functions like backing up disk, scanning/cleaning viruses 
etc.  E.g. Scan disk, Virus Scanner, disk fragmentation etc. 

Utility software is generally called as Application oriented ready-made system programs. 

Functions of System Utility: 

I. Disk Cleanup- Disk Cleanup is a function that comes with all versions of Windows Operating Systems. Disk 
Cleanup allows for you to scan your entire hard drive to search for extra room by deleting any unneccessary 
files such as temporary files from the Internet and cookies that are downloaded when you visit webpages. You 
can find Disk Cleanup in Windows XP by going to the Start menu → All Programs → Accessories → System 
Tools → Disk Cleanup. 

II. Disk Defragmentation- Defragmentation is the process of locating the noncontiguous fragments of data into 
which a computer file may be divided as it is stored on a hard disk, and rearranging the fragments and 
restoring them into fewer fragments or into the whole file. 

III. System Restore- System Restore is a Windows utility that allows a user to restore their computer data to a 
specific former state (known as a restore point), undoing changes made since that time. System Restore can be 
found by going to Start → All Programs → Accessories → System Tools → System Restore 

IV. Disk Compression- Disk compression is a type of function that allows for a program to search your hard 
drive and compress files, particularly old or unused files. It also serves to free up space, which is the main 
function of disk compression software. 

V. Antivirus- It is used to scan computer for viruses and prevent the computer system files from being corrupt. 

APPLICATION SOFTWARE 

Application software is a computer program that performs a specific function, be it educational, personal, or 
business. It is also known as an end-user program or a productivity program.  

Each of the computer application software programs is developed to assist you with a particular process that 
may be related to creativity, productivity, or better communication.  It helps you in completing your tasks, be 
it jotting down notes, completing your online research, setting an alarm, keeping an account log, and even 
playing games. Unlike system software, computer application software programs are specific in their 
functionality and do the job that they are designed to do.  
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They are categorized as-  

1. Presentation software:  Presentation software enables you to put forth your thoughts and ideas with ease 
and with good clarity by using visual information. It lets you display the information in the form of slides. You 
can make your slide more informative and more engrossing by adding text, images, graphs, and videos. It has 
three components: Text editor to input and format text, Insert graphics, text, video, and multimedia files, 
Slideshow to display the information 

2. Web browsers:  These software applications are used to browse the Internet enabling you to locate and 
retrieve data across the web. The most popular ones are Google Chrome and Internet Explorer. 

3. Multimedia software:  This lets you create or record images, and create audio or video files. This software is 
extensively used in animation, graphics, image, and video editing. Popular examples are the VLC media player 
and Windows media player. 

4. Education and reference software: This application software, also termed as academic software, is 
specifically designed to facilitate the learning of a particular subject.  

5. Graphics software:  Graphics software allows you to edit or make changes in visual data or images. It 
comprises illustration and picture editor software. Adobe Photoshop and PaintShop Pro are a few examples of 
graphics software. 

6. Spreadsheet software: Spreadsheet software is used to perform calculations. In this software, data is stored 
in a table format. The intersecting area, called cells, are separated to define fields such as text, date, time, and 
number. It allows users to provide formulas and functions to perform calculations. Microsoft Excel is one good 
example of spreadsheet software. 

7. Database software:  Database software is used to create and manage a database. Also known as a DBMS 
(Database Management System), it helps you organize your data. So, when you run an application, data is 
fetched from the database, modified, and is stored back in the database. Oracle, MySQL, Microsoft SQL Server, 
PostgreSQL, MongoDB, and IBM Db2 are some popular databases. 

8. Word processing software: It is used to format and manipulate text, thus, creating memos, letters, faxes, 
and documents. Word processing software is also used to format and beautify the text. It provides you a 
whole lot of features aside from thesaurus and synonyms and antonyms. Along with Word Art features, the 
font option lets you change font color, effect, and style as per your choice. Grammar and spell-check options 
are also available to check for errors. 

9. Simulation software:  Simulation software is used in the fields of engineering, education, testing, and video 
games, etc. It is used where work on the actual system is unacceptable, inaccessible, or maybe dangerous. It is 
a program that lets you study or observe an operation, or phenomenon through simulation without actually 
doing that operation. The best examples of the simulation are in the field of robotics, flight systems, and 
weather forecast, etc. 

Apart from these, there are several others in the category of application software that serve specific purposes. 
However, application software can also be classified based on their shareability and availability. Some such 
categories are: 

10. Freeware: As the very name indicates, it is available free of cost. You can download it from the Internet 
and use it without any fee. However, this software does not allow you to modify it or charge a fee for 
distributing it. Adobe Reader and Skype are good examples of this software. 
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11. Shareware: This is distributed freely to the users on a trial basis, usually with a limited time offer. The users 
are expected to pay if they want to continue to use the software. Some examples of shareware are WinZip and 
Adobe Acrobat. 

12. Open source: This type of software is available along with the source code that allows you to modify the 
software, and even add features to the software. These could either be free or paid. Moodle and Apache Web 
Server are some examples. 

13. Closed source: Most of the software packages that you use belong to this category. These are usually 
chargeable and have intellectual property rights or patents over the source code. It usually comes with 
restricted use. 
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Microsoft Office, or simply Office, is a family of client software, server software, and services developed by 

Microsoft. It was first announced by Bill Gates on August 1, 1988, at COMDEX in Las Vegas. 

MS office primarily includes Word, Excel, PowerPoint, Access and Outlook. 

MS Word 

MS Word is a word processor developed by Microsoft. It has advanced features which allow you to format and 

edit your files and documents in the best possible way. Used to make professional-quality documents, letters, 

reports, etc. 

• Charles Simonyi, a developer and Richard Brodie, a software engineer, where the two creators of 

MS Word 

• This program was initially named “Multi-Tool Word” but later, was renamed as MS Word 

• It was introduced in 1983 

Using this application program you can add pictures, tables, and charts to your documents. You can also check 

spelling and grammar. 

 Follow these simple steps to open MS Word on your personal computer: 

Start → All Programs → MS Office → MS Word. 

Microsoft Word: 

 Microsoft Word is a word processor developed by Microsoft. 

 It is used for creating, editing, formatting, storing, retrieving and printing of a text document. 

 Microsoft Word's native file formats are denoted either by a .doc or .docx file extension. 

ADVANTAGES: 

1. Business and workplace use of Microsoft Word 

2. MS word uses in Education: 

3. Help to create resumes, notes, and assignments 

4. You can create books, articles, and newsletters 

5. Used to create edit, transcribe, and convert PDF  
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 Office Button- It is located in upper left button corner of the office. 

The options available in the Office Button menu are : 

1. New - Creates a new document 

2. Open - Opens an existing document form disk 

3. Save - Saves the open document to disk 

4. Save As - Saves the open document to disk under a different name 

5. Print -  Prints the open document 

6. Prepare - Prepares the document for distribution, through such tasks as adding a signature on 

encryption 

7. Send - Sends the document to another user by email or fax 

8. Publish - Makes the document publicly available via a document serve or a public web space 

9. Close - Exits the open document. 

 

 

 TITLE BAR:  The bar at the top of the window that bears the name of the window, is known as Title 

Bar.  

 MENU BAR:  A screen element of MS Word that is usually located below the title bar that provides 

categorized option, is called Menu Bar. 

 TOOL BAR: Toolbars provide shortcuts to menu commands. Toolbars are generally located just 

below the Menu bar. 
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Ribbon 

The Ribbon is located at the top of the screen and stretches across the window. The Ribbon is organized into 8 

different 

Tabs;  File, Home, Insert, Page Layout, References, Mailings, Review, and View. Each Tab has several Groups, 

where similar tools and features are found. 

(a)  Home Tab 

The Home tab displays a variety of tools and features used to format and move text. The Home tab can change 

the color, size, font, and alignment of the text. The Home tab can also cut, copy, and paste text. The Home tab 

has 5 groups; Clipboard, Font, Paragraph, Styles and Editing 

(b)  Insert Tab 

The Insert tab displays tools and features used to add an item or special format to the document. The Insert 

tab can add pictures, symbols, or page numbers to the document. The Insert tab has 7 groups; Pages, Tables, 

Illustrations, Links, Header & Footer, Text, and Symbols. 

(c)  Page Layout Tab 

The Page Layout tab displays tools and features used to change the way text and images will be positioned in 

the document. The Page Lausert tab controls the margins and page orientation. The Page Lausert tab has 5 

groups; Themes, Page Setup, Page Background, Paragraph, and Arrange. 

(d)  Reference Tab 

The References tab displays tools and features used in academic or professional writing. The References tab 

will assist with using citations, footnotes, and a table of contents. The References tab has 6 groups; Table of 

Contents, Footnotes, Citations, Captions, Index, and Table of Authorities. 

(e)  Mailings Tab 

The Mailings tab displays tools and features used to print envelopes, labels, and send mass communications. 

The Mailings tab has 5 groups; Create, Start Mail Merge, Write & Insert Fields, Preview Results, and Finish. 
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(f)  Review Tab 

The Review tab displays tools and features used to fix mistakes or write drafts of a document. The Review tab 

can check spelling and grammar, add comments to a section of the document, or change the language of the 

document. The Review tab has 7 groups; Proofing, Language, Comments, Tracking, Changes, Compare, and 

Protect. 

(g)  View Tab 

The View tab displays tools and features to change the way the document looks on the screen. The View tab 

can change the zoom level, display or position the windows for 2 different documents. The View tab has 5 

groups; Document Views, Show, Zoom, Window, and Macros. 

 Ruler 

The ruler is a measurement tool found in MS word that allow the user to align graphics, text, tables, or other 

elements on a page. When enabled the horizontal ruler appears at the top of the document, and the vertical 

ruler is on the left-side of the document. 

 Status Bar 

The status bar, which is a horizontal area at the bottom of the document window in Microsoft Word, provides 

information about the current state of what user are viewing in the window and any other contextual 

information. It shows the Page number(Shows the page number) and Number of words in the document itself. 

 The Vertical and Horizontal and Vertical Scroll Bars 

The vertical and horizontal scroll bars enable you to move up, down, and across your window simply by 

dragging the icon located on the scroll bar. The vertical scroll bar is located along the right side of the screen. 

The horizontal scroll bar is located just above the status bar. To move up and down your document, click and 

drag the vertical scroll bar up and down. To move back and forth across your document, click and drag the 

horizontal scroll bar back and forth. You won't see a horizontal scroll bar if the width of your document fits on 

your screen. 
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MS WORD FEATURES 

 TEXT EDITING 

The ability to change text by adding, deleting and rearranging letters, words, sentences and paragraphs. Text 

editing is the main operation users perform in word processors, which typically also handle graphics and other 

multimedia files.  

 FIND AND REPLACE 

Find and Replace helps you to find words or formats in a document and can let you replace all instances of a 

word or format. This is particularly handy in long documents. To use Find and Replace, use the shortcut Ctrl+H 

or navigate to Editing in the Home tab of the ribbon, then choose Replace. 

Go to Home > Replace or press Ctrl+H. Enter the word or phrase you want to locate in the Find box. Enter your 

new text in the Replace box. 

 ALIGN/ ALIGNMENT 

The alignment keyboard shortcut keys can vary depending on what program is being used and the type of 

computer. However, generally speaking, use Ctrl+L to left align, Ctrl+E to center, Ctrl+R to right align, and 

Ctrl+J to justify text. 

 BULLET 
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Alternatively referred to as a bullet point, a bullet is an asterisk, black dot, circle, or other mark that is found 

before the text. They are utilized to identify key items or denote significance. Bullet points are often used in 

presentations to help organize information and make it easier to read or understand. 

 CLIPBOARD 

The clipboard, also known as pasteboard, is a special location in your computer's memory that temporarily 

stores cut or copied data from a document. Once, something is stored in the clipboard, it can then be pasted 

to a new location. The clipboard holds its information until you cut or copy something else, or log out of the 

computer. For example, a user may copy information from a word processor and paste that information into 

an e-mail message. 

 AutoCorrect 

AutoCorrect is a software feature commonly found in word processing programs, such as Microsoft Word. As 

the name implies, this feature automatically  corrects misspellings and common typos. 

Hit Alt + F7 on your keyboard and it will start with the first misspelled word.  

 FORMATTING TOOLBAR 

Options available in the formatting toolbar 

1. Change the font. 

2. Change the size of the font. 

3. Change the font color. 

4. Make the text bold, italics, or underline. 

5. Change the alignment. 

6. Change the style to currency, percent, or comma. 

7. Increase or decrease the decimal and indent. 

8. Change the borders. 

9. Fill (highlight) the text. 

 

 GRAMMAR CHECKER 

A grammar checker is software or a program feature found in a word processor and is used to find 

grammatical errors. That is to say, it checks for improper sentence structure and word usage (e.g., their 

instead of there), poorly placed or unnecessary punctuation, and other more esoteric errors. An example of a 

software program that includes its own grammar checker is Microsoft Word. Microsoft Word  underlines 

grammar errors with a green squiggly underline as shown in the picture. 

 GUTTER 
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A gutter is a blank area or space that runs between text or pages of a document. Most documents have a 

gutter at the top and bottom of each page. A gutter may be small or large, depending on the size of the 

margins on each page. A larger margin results in a larger gutter. 

 

 THESAURUS 

A thesaurus is a reference tool that is used to locate synonyms (words that are similar in meaning to a 

particular word.)  

 MAIL MERGE 

Mail Merge is a handy feature that incorporates data from both Microsoft Word and Microsoft Excel and 

allows you to create multiple documents at once, such as letters, saving you the time and effort of retyping the 

same letter over and over. 

 SUBSCRIPT AND SUPERSCRIPT 

Subscript 

Abbreviated as sub, subscript refers to words or character that are half the height of a standard character and 

printed lower than the rest of the text. 

EXAMPLE- ABCABC 

Superscript 

Abbreviated as sup, a superscript is a character(s) half the height of a standard character and printed higher 

than the rest of the text. 
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EXAMPLE- ABCABC 

For superscript, press Ctrl, Shift, and the Plus sign (+) at the same time. For subscript, press Ctrl and the 

Equal sign (=) at the same time. 

 

MS WORD SHORT CUT KEYS 

Function key Shortcuts 

• Press F1 to access online Help or the Office Assistant 

• Press F2 to move text or graphics 

• Press F3 to insert an AutoText entry (after Word displays the entry) 

• Press F4 to repeat the last action 

• Press F5 to choose the Go To command (Edit menu) 

• Press F6 to go to next pane or frame 

• Press F7 to launch the Spelling and Grammar check 

• Press F8 to extend a selection 

• Press F9 to update selected fields 

• Press F10 to activate the Menu Bar 

• Press F11 to go to the next field 

• Press F12 to choose the Save As command (File menu) 
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Microsoft Power point:  Microsoft Power point is a part of MS- Office. It was introduced to generate business 

presentation, slide show and graphics on computer system.  

Microsoft PowerPoint is a presentation program, created by Robert Gaskins and Dennis Austin at a software 

company named Forethought, Inc. It was released on April 20, 1987, initially for Macintosh computers only. 

Microsoft acquired PowerPoint for $14 million three months after it appeared. 

“The actual extension for power point after Microsoft office 2007 is *.pptx and for the older versions, it was 

*.ppt.” 

 

Versions 

Versions for Microsoft Windows include: 

• 1990 PowerPoint 2.0 for Windows 3.0 

• 1992 PowerPoint 3.0 for Windows 3.1 

• 1993 PowerPoint 4.0 (Office 4.x) 

• 1995 PowerPoint for Windows 95 (version 7.0) – (Office 95) 

• 1997 PowerPoint 97 - (Office 97) 

 1999 PowerPoint 2000 (version 9.0) (Office 2000) 

• 2001 PowerPoint 2002 (version 10) (Office XP) 

• 2003 PowerPoint 2003 (version 11) (Office 2003) 

• 2007 PowerPoint 2007 (version 12) (Office 2007) 

Use of Power point  

1. Creating business application presentation slide.  

2. Creating graphical objects with animations.  

3. Create artistic slides for general use using art gallery.  

4. To provide training in business world. 

Question: How to open MS PowerPoint on a personal computer? 

Answer: Follow the steps below to open MS PowerPoint on a personal computer: 

1. Click on the start button 

2. Then choose “All Programs” 

3. Next step is to select “MS Office” 

4. Under MS Office, click on the “MS PowerPoint”  
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A blank presentation is open on the screen. According to the requirement, a person can modify the template 

for a presentation and start using the program. 

 

Question: What is a PowerPoint presentation or PPT? 

Answer: A combination of various slides depicting a graphical and visual interpretation of data, to present 

information in a more creative and interactive manner is called a PowerPoint presentation or PPT. 

Question: What is a slide show in a PowerPoint presentation? 

Answer: When all the slides of a PowerPoint presentation are set in series and then presented to a group of 

people, where each slide appears one after the other, is a set pattern, this is known as a PowerPoint slide 

show.  

Question: What all elements can be added to a slide? 

Answer: The following elements can be added to a Powerpoint slide: 

1. Clip Art 

2. Graphs 

3. Tables 

4. Photographs 

5. Charts 

6. Media Clips 

7. Videos 
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Parts of Power Point 

1. The Microsoft Office Button 

In the upper-left corner of the PowerPoint 2007 window is the Microsoft Office button. It›s similar to the old 

File Menu. When user click the button, a menu appears. User can use the menu to create a new file, open an 

existing file, save a file, print, and perform many other tasks. 

 

2. The Quick Access Toolbar 

Next to the Microsoft Office button in the upper left corner is the Quick Access toolbar outlined in red in the 

image above. 

The Quick Access toolbar provides with access to commands that are frequently used. By default, Save, Undo, 

and Redo appear on the Quick Access toolbar. User use Save to save the file, Undo to rollback an action user 

have taken, and Redo to reapply an action user have rolled back. User can customize this toolbar by right 

clicking on it or click the small black down arrow to the right.  

3. The Title Bar 

The Title bar is located at the top in the center of the PowerPoint window. The Title bar displays the name of 

the presentation on which user are currently working. By default, PowerPoint names presentations 

sequentially, starting with Presentation1. When user save user file, user can change the name of user 

presentation. 

4. The Ribbon 

The Ribbon holds all of the commands and features of each of the tabs in the Ribbon. The Tabs are located 

across the top of the ribbon under the Title Bar. These contextual tabs will appear when user have something 

highlighted that calls for it. For example, if user have a picture highlighted on its slide, a Picture Tools tab will 

appear. 

Similar tools are located in Command Groups across the ribbon. 

Each Command Group includes Command Buttons to perform various actions on that group of tools. 

• Clipboard : Contains the cut, copy, paste commands. The Format Painter tool is located here as are 

the Paste Special, Paste as Hyperlink, and Duplicate commands. 

• Slides : All the commonly used commands for creating new slides 

• Font : Includes the most commonly used commands for formatting font 

• Paragraph : Includes all of the paragraph formatting commands, vertical and horizontal alignments, 

text direction, bullets, numbering, indenting, spacing before and after, columns, etc. It also includes 
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the dialog box for tabs. 

• Drawing : Allows to add shapes and draw on slides. This is Format Shape Dialog Box. The Status bar 

generally appears at the bottom of the window.  

5. Status bar 

The Status bar displays the number of the slide that is currently displayed, the total number of slides, and the 

name of the design template in use or the name of the background. 

The Outline tab displays the text contained in presentation in an outline format. The Slides tab displays a 

thumbnail view of all slides. User can click the thumbnail to view the slide in the Slide pane. 

The View buttons appear near the bottom of the screen. User can use the View buttons to change between 

Normal view, Slider Sorter view, and the Slide Show view. 

POWERPOINT VIEWS 

Normal View 

Normal view splits the screen into three major sections: the Outline and Slides tabs, the Slide pane, and the 

Notes area. 

• The Outline and Slides tabs are on the left side of window. They enable to shift between two 

different ways of viewing your slides. The Slides tab shows thumbnails of your slides. The Outline 

tab shows the text on slides.  

• The Slide pane is located in the center of your window. The Slide pane shows a large view of the 

slide on which user currently working.  

• The Notes area appears below the Slide pane. User can type notes on the Notes area. 

 

Slide Sorter View 

Slide Sorter view shows thumbnails of all slides. In Slide Sorter view, user can easily add, delete, or change 

their order of your slides. 
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Slide Show View 

Use the Slide Show view when want to view slides, as they will look in final presentation. When in Slide Show 

view: 

 

• Esc - Returns to the view using previously. 

• Left-clicking - Moves you to the nextslide or animation effect. When reach the last slide, 

automatically return to previous view. 

• Right-clicking - Opens a pop-up menu. User can use this menu to navigate the slides, add speaker 

notes, select a pointer, and mark presentation. 

 

Zoom In & Zoom Out 

• MINIMUM ZOOM- 10% 

• MAXIMUM ZOOM- 400% 

 

 

 

 

COMPONENTS OF SLIDE 
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• Title Placeholder : It is use to write title of slide 

• Text Placeholder: It is use to descriptive text 

• Object Placeholder: It is use to insert picture, graphics, chart etc. 

 

 

Add New slide 

• Click CTRL+M from keyboard or select New Slide option from Insert Menu 

• Slide Layout pane will be appear on right side, click on appropriate layout. 

Template 

A template, also called a presentation design, lets you create a presentation without worrying about design 

elements. The template defines the color, background, and font of the slides. PowerPoint has many templates, 

which you can preview and select in the New Presentation window. 

PowerPoint also lets you customize the templates. For instance, you can change the background color or 

typeface of a template. 

EXIT OR QUIT FROM POWERPOINT 

• Choose Exit Option from File menu 

OR 

• Press ALT+F4 

OR 

• Click X button at the top right corner on title bar of the PowerPoint 

OR 

• CTRL+W 

ANIMATIONS 

To add a special visual or sound effect to text or an object is called Animation. 
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For example, you can have your text bullet points fly in from the left, one word at a time, or hear the sound of 

applause when a picture is uncovered. Animations makes presentation more effect. There are variety of 

options available for adding animations to presentation. 

 

Slide Transition 

A slide transition is how one slide is removed from the screen and the next slide is displayed during a 

presentation. 

To add transitions to a presentation click on the slide sorter view, located at the bottom of the screen. 

Thumbnails of all the slides in your presentation will appear. Click on the Transitions tab. The transitions tab 

contains the Transitions to This Slide group. From this group choose a special effect to be applied during the 

transition between the previous slide to the next slide. 

To apply transition schemes to all the slides in your presentation select Apply to All. 

 

Triggers 

Triggers give you specific click points for controlling animation, and are especially useful when you want 

several effects on a slide. In the Animation Pane, select the animated shape or other object that you want to 

trigger to begin playing when you click it. 

 

In MS Powerpoint, we can add many types of Image and Sound formats such as : .gif, .png, .bmp, .jpg, .wav, 

.mid, mp4 etc 
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IMPORTANT SHORTCUTS 

Ctrl + Letters 

Ctrl + A Selects all the objects on the active slide 

Ctrl + B Toggles bold on the current selection 

Ctrl + C Copies the current selection to the clipboard (Edit > Copy) 

Ctrl + D Make a duplicate of the selected slide (Edit > Duplicate) 

Ctrl + E Centre aligns the current selection 

Ctrl + F Displays the (Edit > Find) dialog box 

Ctrl + G Displays the (View > Grid and Guides) dialog box 

Ctrl + H Displays the (Edit > Replace) dialog box 

Ctrl + I Toggles italics on the current selection 

Ctrl + J Justifies the current selection 

Ctrl + K Displays the (Insert > Hyperlink) dialog box (in a textbox) 

Ctrl + L Left aligns the current selection 

Ctrl + MInserts a new slide (Insert > New Slide) 

Ctrl + N Creates a new presentation (File > New) 

Ctrl + O Displays the (File > Open) dialog box 

Ctrl + P Displays the (File > Print) dialog box 

Ctrl + R Right aligns the current selection 

Ctrl + S Saves, Displays the (File > Save As) dialog box if a new presentation 

Ctrl + T Displays the (Format > Font) dialog box 

Ctrl + U Toggles (continuous) underlying of the selection 

Ctrl + V Pastes the entry from the clipboard (Edit > Paste) 
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Ctrl + W Closes the active presentation or window (File > Close) 

Ctrl + X Cuts the current selection to the clipboard (Edit > Cut) 

Ctrl + Y Repeats the last Presentation action (Edit > Repeat) 

Ctrl + Z Undo the last Presentation action (Edit > Undo) 

Function Keys 

F1 Display Help or the Office Assistant 

F2 Select the text box containing an object or text 

F4 Repeats the last presentation action (Edit > Repeat) (not Format Autoshape dialog) 

F5 Runs the presentation (View > Slide Show) 

F6 Moves to the next pane in the presentation (clockwise) 

F7 Displays the (Tools > Spelling) dialog box 

F10 Toggles the activation of the Menu Bar 

F12 Displays the (File > Save As) dialog box 

Ctrl + Function 

Ctrl + F4 Closes the active presentation or window (File > Close) 

Ctrl + F5 Restore the size of the active presentation or window 

Ctrl + F6 Moves to the next presentation window 

Ctrl + F7 Activates the Move window command 

Ctrl + F8 Activates the Resize window command 

Ctrl + F9 Minimises the size of the active presentation or window 

Ctrl + F10 Maximise the size of the active presentation or window 

Ctrl + F12 Displays the (File > Open) dialog box 
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 MS Access is a Database Management system which was launched by Microsoft. It is a part of the 
Microsoft Office suite and stores data in its own format. 

 Microsoft Access is a database management system (DBMS) that combines the relational 
Microsoft Jet Database Engine with a graphical user interface and software-development tools.  
 

 It handles data management tasks.  
 Microsoft Access allows users to manipulate large amounts of information and retrieve any part of 
the information.  
 It is a structured database containing data tables that are arranged in a uniform structure of records 
and fields.  
 A spreadsheet is a table used by small organisations that operates with a limited amount of data 
but for big organisations a Database Management System is preferred because it needs storing huge amount 
of data and retrieves it much faster.  
 In database management system the content and the location of the data is defined by meta data. 
 

 On November 13, 1992, the first version on MS Access was released by Microsoft 

 Before MS Access 2007, the file extension was ‘.mdb’, but in MS Access 2007 the extension has 
been changed to ‘.accdb’ extension.  

 Early versions of Access cannot read accdb extensions but MS Access 2007 and later versions can 
read and change earlier versions of Access. 

Differences between Access and Excel 

Microsoft Access and Excel are very similar yet very different. Here, are some important difference points 
between both of them- 

Access Excel 

Deals with text, numbers, files and all kinds of 

data 

Microsoft Excel generally deals with numerical 

data 

All the data is stored one time, in one place. Lots of worksheets or documents are a store 

with similar, repeated data. 

Helps you to build highly functional data entry 

forms and report templates. 

Only the primary data entry screen is available. 
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Users will be able to enter the data more 

efficiently and accurately. 

Data accuracy and speed is not much because of 

the format. 

 

USES OF MS ACCESS 

MS Access can be used to develop application software and is generally used by data architects, software 
developers and power users. Following are the major uses of MS Access: 

 Manage accounts and bills 

 Store data in the form of tables and edit or customise them later as per the requirement of the user 

 It can be used to make our websites 

 Comparing data or finding a relationship between the existing data can be done using Access 

 

 

How to start MS Access Program 

Click start → All programs → Microsoft office → Microsoft Access. 

 

 

How to Create an Access Database 
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 Click the File tab. 

 Choose New. 

 Access displays a variety of database templates you can use. 

 Click an icon, such as Blank Database, or any database template. When you click a template, a 
window appears; you see a preview of your template. 

 Click in the File Name text box and type a descriptive name for your database. 

 Click the Create button to create your database file. 

 

 Access displays a blank database. 

 

 

 Click the Click to Add heading. Access displays a menu for defining what type of data that field can 
hold, such as text or numbers. 
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 Choose Long Text. Access displays a generic field name, such as Field1. 

 Type a name for your field (such as First Name or Salary). 

 Press Enter. 
Access displays another Click to Add column; its menu lets you choose the type of data to store in 
the next field. 

 Choose Long Text or any other data type you want the field to hold. 
Access displays another generic field, such as Field1. 

 Type a name for your field, such as Last Name. 

 Repeat Steps 9 through 11 for each additional field you want to create. 

 When you have finished adding fields, press Esc on the keyboard. 

MS ACCESS OBJECTS 

Tables: Tables are where the actual data is defined and entered. Tables consist of records (rows) and fields 
(columns). 

• Field : A space allocated for a particular item of information is field. Afield is a column in a table. 
SQL Server supports more fields, but only 255 fields are visible in Access. The definition of a field 
includes the name of the field, the type of data that is stored in the field, and any validation rules 
that you must have to validate the stored data. For example a tax form, contains a number of 
fields such as name, address, income and so on. In database systems, fields are the smallest units 
of information. In spreadsheets, fields are called cells. 

• Record : In database management systems, a record is a row in a table.We may store any number 
of records in a table. Records are composed of fields, each of which contains one item of 
information. A set of records makes a file. For example, a personnel file contains records that 
have fields such as name, address and a phone number etc.  

Queries: Queries are basically questions about the data in a database. A query consists of specifications 
indicating which fields, records, and summaries want to see from a database. Queries allow to extract data 
based on the criteria user define. 
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Forms : Forms are designed to ease the data entry process. For example, To create a data entry form that 
looks exactly like a paper form.  

 

Reports: When a user want to print records from user database, design a report. Access even has a wizard to 
help produce mailing labels. 

Pages: A data access page is a special type of Web page designed for viewing and working with data from the 
Internet or an intranet. This data is stored in a Microsoft Access database or a Microsoft SQL Server database. 

Macros: A macro is a set of one or more actions that each performs a particular operation, such as opening a 
form or printing a report. Macros can help user automate common tasks. For example, user can run a macro 
that prints a report when a user clicks a command button. 

Modules: A module is a collection of Visual Basic for Applications declarations and procedures that are stored 
together as a unit. This allows a set of pre-defined instructions to be created by a programmer in the database. 
They can be used throughout the database. 

OTHER IMPORTANT TERMS 
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Database File : A database is a collection of related information that is organized so that it can easily be 
accessed, managed and updated. We organize files by storing them in folders. 

“The process of arranging data in logical sequence is called sorting.” 

It is an integrated collection of logically-related records that provide data for one or more multiple uses. We 
can also perform operations on the data that is in a database. 

File updating : In computing, reviewing and altering the records in a file to ensure that the information they 
contain is accurate and up-to-date. Three basic processes are involved:  

 adding new records, 

 deleting existing records, 

 amending existing records. 

Database engine : A database engine is a part of a DBMS. It provides a link between the DBMS and the 
physical data on the hard disk. 

Field Name : It is a label provide for a field that specifies the type of information contained in a particular field. 

Rules for naming field 

a. It can be up to 64 characters long. 
b. The naming cannot include control characters. 
c. It cannot begin with leading spaces. 
d. It can include any combination of letters, numbers, spaces and special characters except a period 

(.), an exclamation mark (!), an accent grave (`) and brackets ([ ]). 

Field Type/Data Type : It specifies the type of data stored in the field such as textual data and numerical data 
or combination of both. The default size of data type is 50 in MS-Access. 

 

Field Length : Field refers length or width to the maximum number of characters that a field can contain. 
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MS-Access View- You can create a table by two most popular ways 

a. Database View : It shows the data in the database and also allows you to enter and edit the data 
but not  allow to change the database. 

b. Design View : It allows you to create or change the table and also set the keys. 
c. Filtering Data : It enables to display only those records in a table that meet a specified filter 

criterion. 
 

Primary Key - Primary key is a field or group of fields that uniquely identify records in a table. Every table can 
have only one primary key Primary key cannot be null value it always has unique value. Primary key is used to 
relate one table to another as a foreign key. Foreign key: Foreign key is a key in a table that refers to primary 
key Held in another table. 

 

The differences between primary key and foreign key 

Primary Key Foreign Key 

 It is a column or a set of column that can 
be used to uniquely identify a row in a 
table. 

 It is a column or a set of column that refer 
to a primary key or a candidate key of 
another table. 

 A table can have a single primary key that 
can reference different tables. 

 A table can have multiple foreign key that 
can reference different tables. 

 

POINTS TO REMEMBER 

 Filtering Data : It enables to display only those records in a table that meet a specified filter 
criterion. 
 

 Validation Rule : It is a condition that must be met before the data is accepted into the database. 
 Validation Text - It appears if a validation rule is not satisfied. 

 
 The Required field - property makes data entry compulsory so that the field cannot be left blank. 

 
 Relationship : It is an association between access table or quarries that use related field. It is a link 

between tables and enables us to accessed data from both tables simultaneously.  
Relationship can be divided in three categories; One-in-One, One-to-Many and Many-to-Many. 
 

 Attributes : Attributes can be defined as the characteristics of an entity to identify in uniquely. Such 
as student’s attributes are his Roll-No, Section, Name etc. 
 

 Memo- It allows long blocks of text, that use text formatting 
 

 OLE Object- it is an acronym for object linking embedding. It can store objects such as a video clip. a 
picture, word document etc. 
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Microsoft Excel is a spreadsheet developed by Microsoft for Windows, macOS, Android and iOS. It features 
calculation, graphing tools, pivot tables, and a macro programming language called Visual Basic for 
Applications (VBA). Microsoft Excel is a spreadsheet tool capable of performing calculations, analyzing data 
and integrating information from different programs. 

Running Excel is not different from running any other Windows program.  

1. Click on start menu 
2. Point to all programs 
3. Point to Microsoft Excel 
4. Click on Microsoft Excel 

‘ By default, documents saved in Excel (2007 onwards) are saved with the .xlsx extension whereas the file 
extension of the prior Excel Versions(2003) are .xls’  

EXCEL 2007 versus EXCEL 2003 and earlier 

 For basic data analysis using the Data Analysis Toolpack, such as descriptive statistics and 
regression, versions of Microsoft Excel from 1997 on are adequate. 

 However, the user interface for Excel 2007 is much different from that in earlier versions.  

 The File Menu is replaced with the Microsoft Office Button  . This is used to open, save and print 
files. 

 The other Menus (Edit, View, Insert, Format, Tools, Data, Window and Help) and drop-down 
dialog boxes and toolbar icons have been greatly rearranged and replaced by the Microsoft Office 
fluent user interface that uses Ribbons and Groups. 
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SPREADSHEET 

 An electronic document in which data is arranged in the rows and columns of a grid and can be 
manipulated and used in calculations. 

 A spreadsheet is collection of electronic sheet which contain various type of data in to rows and 
columns. 

 An arrangement of cells in columns and rows used to organize, analyze, calculate, and report 
information. 

The Microsoft Office Button- In the upper-left corner of the Excel 2007 window is the Microsoft Office 
button.When you click the button, a menu appears. You can use the menu to create a new file, open an 
existing file, save a file, print and perform many other tasks. 

The Quick Access Toolbar 

Next to the Microsoft Office button is the Quick Access toolbar. The Quick Access toolbar gives you quick 
access to commands you frequently use. 

The Title Bar 

Next to the Quick Access toolbar is the Title bar. On the Title bar, Microsoft Excel displays the name of the 
workbook you are currently using. At the top of the Excel window, you should see "Book 1 - Microsoft Excel" or 
a similar name. 

The Ribbon Bar 

The commands are organized by Tab and Group. At the highest level is the Ribbon for each Tab. Here this is is 
shown for the Home Tab. 

Various editing and formatting can be done on an Excel spreadsheet. Discussed below are the various 
features of MS Excel.  

1. Home 

Comprises options like font size, font styles, font colour, background colour, alignment, formatting options and 
styles, insertion and deletion of cells and editing options 

2. Insert 

Comprises of options like table format and style, inserting images and figures, adding graphs, charts and 
sparklines, header and footer option, equation and symbols 

3. Page Layout 

Themes, orientation and page setup options are available under the page layout option 
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4. Formulas 

Since tables with a large amount of data can be created in MS excel, under this feature, you can add formulas 
to your table and get quicker solutions  

5. Data 

Adding external data (from the web), filtering options and data tools are available under this category 

6. Review 

Proofreading can be done for an excel sheet (like spell check) in the review category and a reader can add 
comments in this part  

7. View 

Different views in which we want the spreadsheet to be displayed can be edited here. Options to zoom in and 
out and pane arrangement are available under this category 
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 CELL- The intersection of a row and column is called a cell.  
 

 Active Cell: The active cell is the cell in the spreadsheet that is currently selected for data entry. You 
can change which cell is the active cell by clicking the left mouse button once or using the arrow 
keys on the keyboard. The current active cell can be identified as being the one that has a darker 
black border around it. Also, the active cell reference is listed in the Name Box directly above the 
spreadsheet's column headings. 
 

 
 CELL NAME/ADDRESS- Cells are identified by the Cell Name (or Reference, which is found by 

combining the Column Letter with the Row Number. For example the cell in Column "C" in Row "3" 
would be cell C3. Cells may contain Labels, Numbers, Formulas or Functions. 
 

 COLUMNS AND ROWS-  Upto Excel 2003, the standard amount of columns was 256 and 65536 
rows. (columns represented in alphabets & rows represented in numbers) 
EXCEL 2007 onwards , maximum number of rows per sheet increased to 1048576 and columns to 
16384. 
 

 Name Box: The name box appears to the left of the formula bar and displays the name of the 
current cell. Unless you define a cell or range of cells with a specific name, the name box will display 
the cell reference of the active cell. 
 

 Formula Bar: The formula bar appears directly above the column headings of a spreadsheet and 
will display what has been typed into the active cell. For example, if you click on a cell that contains 
the formula =A3+C3, the cell itself will show the result of the formula. The formula bar, however, 
will display what has actually been typed into the cell which, in this case, is =A3+C3. 
 

 
 Function: Functions are built-in formulas that are used to enter either commonly used or very 

complex formulas. Like formulas, functions begin with an equal sign "=" and use cell references in 
their format. One commonly used function is the Sum function, which will add up the values in a 
range. The function: =sum(H2:H25) would add all values contained in cells H2 through H25 and 
return the result when the enter key is pressed. 
 

 Workbook: A workbook is a collection of worksheets that are saved together in one file. Individual 
worksheets can be given descriptive names and you can switch from one worksheet to another by 
using the sheet tabs that appear beneath the worksheet grid area. 

 Merging Cells: Ms excel allows merging of one cell with adjacent cell ( that are blank) to form a big 
cell. It is useful especially while creating a decorative title for thr worksheet. 

To merge and center two or more cells follow these steps: Select the cells. Press and release ALT key, 
following by H, M, and M key on keyboard. 
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The basics of Excel formulas 

FORMULAE: Excel formulae can be used to perform simple calculations on the data like addition, 
subtraction, multiplication and division. One of the significant features of a spreadsheet program is its 
ability to manipulate data and perform simple and complex calculations effieicntly. Formulae usually consist 
of one or more cell addresses or values and a mathematical operator such as +, -, * and /. 

For example, =A2+A2+A3+A4 is a formula that adds up the values in cells A2 through A4. 

Operators: 

 ()   PARANTHESIS 

 ^    EXPONENTIAL 

 *    MULTIPLICATION 

 /     DIVISION 

 +     ADDITION 

 -     SUBSTRACTION 

Functions: Functions are pre-designed formulas that save you the time and trouble of creating commonly 
used or complex equations. Excel includes hundreds of functions that you can use alone or in combination 
with other formulas or functions. Functions perform a variety of calculations, from adding, averaging, and 
counting, to more complicated tasks, such as calculating the monthly payment amount of a loan. you can 
enter a function manually if you know its name and all the required arguments, or you can easily insert a 
function using the paste Function feature. 

For example, instead of specifying each value to be summed like in the above formula, you can use the SUM 
function to add up a range of cells: =SUM(A2:A4) 

Excel Macros: An Excel macro is an action or a set of actions that you can record, give a name, save and run 
as many times as you want and whenever you want. Macros help you to save time on repetitive tasks 
involved in data manipulation and data reports that are required to be done frequently. 

MS EXCEL SHORT CUTS 

 Ctrl + N Create a new workbook. 

 Ctrl + O Open an existing workbook. 

 Ctrl + S Save the active workbook. 

 Ctrl + W Close the active workbook. 

 Ctrl + C Copy the contents of the selected cells to Clipboard. 

 Ctrl + X Cut the contents of the selected cells to Clipboard. 

 Ctrl + V Insert the contents of the Clipboard into the selected cell(s). 

 Ctrl + Z Undo your last action.  

 Ctrl + P Open the "Print" dialog. 
 

Navigating and viewing data 

 Ctrl + F1 Show / hide the Excel Ribbon. Hide the ribbon to view more than 4 rows of data. 

 Ctrl + Tab Switch to the next open Excel workbook. 

 Ctrl + PgDown Switch to the next worksheet. Press Ctrl + PgUp to switch to the previous 
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sheet. 

 Ctrl + G Open the "Go to" dialog. Pressing F5 displays the same dialog. 

 Ctrl + F Display the "Find" dialog box. 

 Home Return to the 1st cell of the current row in a worksheet. 

 Ctrl + Home Move to the beginning of a worksheet (A1 cell). 

 Ctrl + End Move to the last used cell of the current worksheet, i.e. the lowest row of the 
rightmost column. 
 
 

Selecting Cells 

 Shift+Left/Right Arrow: Extend the cell selection to the left or right 

 Shift+Space: Select the entire row 

 Ctrl+Space: Select the entire column 

 Ctrl+Shift+Space: Select the entire worksheet 

 Ctrl + A Select the entire worksheet. If the cursor is currently placed within a table, press once 
to select the table, press one more time to select the whole worksheet. 

 
 
Formatting Cells 

 Ctrl+B: Add or remove bold to the contents of a cell, selected data, or selected cell range 

 Ctrl+I: Add or remove italics to the contents of a cell, selected data, or selected cell range 

 Ctrl+U: Add or remove underline to the contents of a cell, selected data, or selected cell range 

 Alt+H+H: Select a fill color 

 Alt+H+B: Add a border 

 Ctrl+Shift+&: Apply outline border 

 Ctrl+Shift+_ (Underline): Remove outline border 

 Ctrl+9: Hide the selected rows 

 Ctrl+0: Hide the selected columns 

 Ctrl+1: Open the Format Cells dialog box 

 Ctrl+5: Apply or remove strikethrough 
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ONE LINERS FOR MS EXCEL 

 Maximum Length of formula contents- 8,192 characters 

 Maximum Users who can open and share a shared workbook at the same time- 256 

 What do you mean by a Workspace- Group of Workbooks 

 The first cell in EXCEL worksheet is labeled as- A1 

 What happens when dollar signs ($) are entered in a cell address- An absolute cell address is 

created 

 What are the tabs that appear at the bottom of each workbook called Sheet tabs 

 What is the keyboard shortcut for creating a chart from the selected cell range- F11 

 Which of the following shortcuts can be used to insert a new line in the same cell- Alt + Enter 

 If particular workbook have to open each time Excel started, where that workbook should be 

laced- XLSTART Folder 

 What is the shortcut key to hide entire row- CTRL + 9 

 What is the shortcut key to insert a new comment in a cell- Shift + F2 

 What is the shortcut key to insert new sheet in current workbook- Shift + F11 

 Which one is the last column header in Excel 2007- XFD 

 In maximum, how many sheets can be set as default while creating new workbook- 255 

 In EXCEL, you can sum a large range of data by simply selecting a tool button called- Auto sum 

 Getting data from a cell located in a different sheet is calledReferencing 

 Concatenation of text can be done using- Ampersand (&) 

 Which language is used to create macros in Excel- Visual Basic 

 Multiple calculations can be made in a single formula using- Array Formula 
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INTERNET- The Internet is a global system of interconnected computer networks that use the standard 
Internet protocol suite (TCP/IP- called the backbone of internet) to link various billion devices worldwide. It is 
an international network of networks that consists of millions of private, public, academic, business, and 
government packet switched networks, linked by a broad array of electronic, wireless, and optical networking 
technologies.  

HISTORY OF INTERNET 

The Internet emerged in the United States in the 1970s but did not become visible to the general public until 
the early 1990s. By 2020, approximately 4.5 billion people, or more than half of the world’s population, were 
estimated to have access to the Internet. 

The first workable prototype of the Internet came in the late 1960s with the creation of ARPANET, or the 
Advanced Research Projects Agency Network. Originally funded by the U.S. Department of Defense, ARPANET 
used packet switching to allow multiple computers to communicate on a single network. 

The technology continued to grow in the 1970s after scientists Robert Kahn and Vinton Cerf developed 
Transmission Control Protocol and Internet Protocol, or TCP/IP, a communications model that set standards 
for how data could be transmitted between multiple networks.  

ARPANET adopted TCP/IP on January 1, 1983, and from there researchers began to assemble the “network 
of networks” that became the modern Internet. The online world then took on a more recognizable form in 
1990, when computer scientist Tim Berners-Lee invented the World Wide Web. While it’s often confused with 
the internet itself, the web is actually just the most common means of accessing data online in the form of 
websites and hyperlinks. 

During 1991-1993 commercial use of Internet took its speed.  

• For the first time, on 15 August 1995 VSNL (Videsh Sanchar Nigam Limited) and ISP (Internet Service 
Provider) launched Internet services in india.  

• The First political party of India is Bharatiya Janata Party, which created its own website on internet.  
• First telephone directory on internet was made available by Sikkim state.  
• India's first Hi-speed rural broadband network has been commissioned in district of Idukki, Kerala. 

Ways To Connect To Internet 

The different ways in which one can connect to the Internet are discussed below in brief: 

Dial-Up – In such connections, users are required to link their phone line to a computer to access the Internet. 
Under this connection, the user cannot make or receive phone calls through tier home phone service 

Broadband – Provided either through cable or phone companies, Broadband is a high-speed internet 
connection which is widely used today. The term broadband is shorthand for broad bandwidth. Broadband 
Internet connections  such as DSL and cable are considered high-bandwidth connections. Although many DSL 
connections can be considered broadband, not all broadband connections are DSL. 

  •  DSL : DSL which stands for Digital Subscriber Line, uses existing 2-wire copper telephone 
line connected to one’s home so service is delivered at the same time as landline telephone service. Customers 
can still place calls while surfing the Internet. 

  •  Cable : Cable Internet connection is a form of broadband access. Through use of a cable 
modem, users can access the Internet over cable TV lines. Cable modems can provide extremely fast access to 
the Internet. 
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Wireless Connection – Wi-fi and Mobile service providers fall under this category. Internet connectivity is 
made via radio waves and the Internet can be connected anywhere, irrespective of the location. Given below 
are a few examples of wireless connection: 

Wi-fi – Wireless Fidelity or wi-fi allows high-speed internet connectivity without the use of wires 

WI-MAX- Wi-Max stands for Wireless Inter-operability for Microwave Access. Wi-Max uses spectrum to deliver 
connection to network and handle a larger inter-operable network. Wi-Max is used in MAN applications.  Wi-
Max uses spectrum to deliver connection to network. Wi-Max is used to provide internet services such as 
Mobile Data and hotspots. 

Sr. 
No. 

Key Wifi WiMax 

1 
Definition Wifi stands for Wireless Fidelity. WiMax stands for Wireless Inter-operability 

for Microwave Access. 

2 

Usage WiFi uses Radio waves to create 
wireless high-speed internet and 
network connections. A wireless 
adapter is needed to create hotspots. 

WiMax uses spectrum to deliver 
connection to network and handle a larger 
inter-operable network. 

3 
IEEE Wifi is defined under IEEE 802.11x 

standards where x defines various WiFi 
versions. 

WiMax is defined under IEEE 802.16y 
standards where y defines various WiMax 
versions. 

4 Usage Wifi is used in LAN applications. WiMax is used in MAN applications. 

5 
QoS Wifi does not gurrantee Quality of 

Service, QoS. 
WiMax guarantees Quality of Service, QoS. 

6 
Network 
Range 

Wifi network ranges at max 100 
meters. 

WiMax network ranges to max 90 kms. 

7 
Transmission 
speed 

Wifi transmission speed can be upto 54 
mbps. 

WiMax transmission speed can be upto 70 
mbps. 

 

Hotspots: Hot-spots are sites that offer Internet access over a wireless local area network (WLAN) by  way of a 
router that then connects to an Internet service provider. Hot-spots utilize Wi-Fi technology,  which allows 
electronic devices to connect to the Internet or exchange data wirelessly through radio  waves. Hotspots can 
be phone-based or free-standing, commercial or free to the public. 

Mobile Phones – All smartphones are now equipped with an option for Internet connectivity which can be 
availed using Internet vouchers and packs. No external connection or wire is required for these 

Satellite – Where broadband connections are unavailable, satellites are used for wireless Internet connectivity 
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Integrated Services Digital Network – ISDN allows users to sent audio or video data using telephone lines.The 
installation of an ISDN adapter is required at both ends of the transmission—on the part of the user as well as 
the Internet access provider. 

NETWORK PROTOCOLS 

In networking, a protocol is a set of rules for formatting and processing data. Network protocols are like a 
common language for computers. The computers within a network may use vastly different software and 
hardware; however, the use of protocols enables them to communicate with each other regardless. 

On the Internet, there are different protocols for different types of processes. Protocols are often discussed in 
terms of which OSI model layer they belong to. 

ISO/OSI Network Model 

The standard model for networking protocols and distributed applications is the International Standard 
Organization’s Open System Interconnect (ISO/OSI) model. It defines seven network layers. 

 

There are various types of protocols that support a major and compassionate role in communicating with 
different devices across the network. These are: 

1. Transmission Control Protocol (TCP): TCP is a popular communication protocol which is used for 
communicating over a network. It divides any message into series of packets that are sent from 
source to destination and there it gets reassembled at the destination. 

2. Internet Protocol (IP): IP is designed explicitly as addressing protocol. It is mostly used with TCP. The 
IP addresses in packets help in routing them through different nodes in a network until it reaches the 
destination system. TCP/IP is the most popular protocol connecting the networks. 

3. User Datagram Protocol (UDP): UDP is a substitute communication protocol to Transmission Control 
Protocol implemented primarily for creating loss-tolerating and low-latency linking between different 
applications. 

4. Post office Protocol (POP): POP3 is designed for receiving incoming E-mails. 
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5. Simple mail transport Protocol (SMTP): SMTP is designed to send and distribute outgoing E-Mail. 
6. File Transfer Protocol (FTP): FTP allows users to transfer files from one machine to another. Types of 

files may include program files, multimedia files, text files, and documents, etc. 
7. Hyper Text Transfer Protocol (HTTP): HTTP is designed for transferring a hypertext among two or 

more systems. HTML tags are used for creating links. These links may be in any form like text or 
images. HTTP is designed on Client-server principles which allow a client system for establishing a 
connection with the server machine for making a request. The server acknowledges the request 
initiated by the client and responds accordingly. 

8. Hyper Text Transfer Protocol Secure (HTTPS): HTTPS is abbreviated as Hyper Text Transfer Protocol 
Secure is a standard protocol to secure the communication among two computers one using the 
browser and other fetching data from web server. HTTP is used for transferring data between the 
client browser (request) and the web server (response) in the hypertext format, same in case of 
HTTPS except that the transferring of data is done in an encrypted format. So it can be said that https 
thwart hackers from interpretation or modification of data throughout the transfer of packets. 

9. Telnet: Telnet is a set of rules designed for connecting one system with another. The connecting 
process here is termed as remote login. The system which requests for connection is the local 
computer, and the system which accepts the connection is the remote computer. 

10. Gopher: Gopher is a collection of rules implemented for searching, retrieving as well as displaying 
documents from isolated sites. Gopher also works on the client/server principle. 

11. PPP: In computer networking, Point-to-Point Protocol (PPP) is a data link layer (layer 2) 
communication protocol between two routers directly without any host or any other networking in 
between. It can provide connection authentication, transmission encryption, and data compression. 

PPP is used over many types of physical networks, including serial cable, phone line, trunk line, cellular 
telephone, specialized radio links, ISDN, and fiber optic links such as SONET. Internet service providers (ISPs) 
have used PPP for customer dial-up access to the Internet, since IP packets cannot be transmitted over a 
modem line on their own without some data link protocol that can identify where the transmitted frame starts 
and where it ends. 

12. VoIP- VoIP (voice over Internet Protocol) is the transmission of voice and multimedia content over an 
internet connection. VoIP allows users to make voice calls from a computer, smartphone, other 
mobile devices, special VoIP phones. 

Intranet 

Intranet is defined as private network of computers within an organization with its own server and firewall. 
Moreover we can define Intranet as: 

 Intranet is system in which multiple PCs are networked to be connected to each other. PCs in 
intranet are not available to the world outside of the intranet. 

 Usually each company or organization has their own Intranet network and members/employees of 
that company can access the computers in their intranet. 

 Every computer in internet is identified by a unique IP address. 

 Each computer in Intranet is also identified by a IP Address, which is unique among the computers 
in that Intranet. 
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Extranet 

Extranet refers to network within an organization, using internet to connect to the outsiders in controlled 
manner. It helps to connect businesses with their customers and suppliers and therefore allows working in a 
collaborative manner. 

Extranet is implemented as a Virtual Private Networks (VPN) because it uses internet to connect to corporate 
organization and there is always a threat to information security. VPN offers a secure network in public 
infrastructure (Internet). 

 

IMPORTANT TERMS RELATED TO INTERNET 

WWW (World Wide Web)- The World Wide Web (abbreviated as WWW or W3 commonly known as the Web) 
is a system of interlinked hypertext documents that are accessed via the Internet. With a web browser, one 
can view web pages that may contain text, images, videos, and other multimedia and navigate between them 
via hyperlinks. 

Website- A website is a collection of webpages that are under 1 domain (such as google.com). For example if 
there is a company that owns abccompany.com then this website will have several Webpages like Home, 
About Us, Contact Us, Testimonials, Products, Services, FAQ’s, and others. All of these pages together make up 
a Website. 

Web Pages- A webpage is an independent page of a Website. For example a webpage would be the 
testimonials page. A web page can be accessed by typically one URL in a browser and that page can be copied 
and or send to a friend for review whereas websites are collections of multiple page that must be navigated to 
view other content. 

Home Page - The home page is the first page that a visitor discovers when he wants to visit your site. There is 
usually just one. 

Web Address/URLs (Uniform Resource Locator)- A URL (Uniform Resource Locator; also known as a web 
address) is a distinct web address on the Internet for a web page, a PDF file or any other file format available. 
It is easy for humans to remember URLs but the computer cannot “understand” this format. For example, the 
URL of a web page may be www.xyz.com, and  its IP address 123.456.789.011. 

Syntax: 

Every HTTP URL consists of the following, in the given order: 

• the scheme name (commonly called protocol) 
• a colon, two slashes 
• a host, normally given as a domain name but sometimes as a literal IP address 
• optionally a colon followed by a port number 
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• the full path of the resource 130 Basics of Internet Technology 

Web Server- A web server is a computer system that processes requests via HTTP, the basic network protocol 
used to distribute information on the World Wide Web. The term can refer either to the entire system, or 
specifically to the software that accepts and supervises the HTTP requests. The most common use of web 
servers is to host websites, but there are other uses such as gaming, data storage, running enterprise 
applications, handling email, FTP, or other web uses. 

Three of the most popular web servers on the web are: 

• Apache HTTP Server- Apache HTTP Server (also referred to as simply “Apache”) has, at the time of 
writing, been the most popular web server on the web since 1996. Apache is developed and 
maintained by the Apache Software Foundation, which consists of a decentralized team of 
developers. The software is produced under the Apache licence, which makes it free and open source. 
Apache is available for a range of operating systems, including Unix, Linux, Novell Netware, Windows, 
Mac OS X, Solaris, and FreeBSD.  

• Microsoft Internet Information Services (IIS)- IIS is, at the time of writing, the second most popular 
web server on the web. It is however, gaining market share, and if the current trend continues, it 
won’t be long before it overtakes Apache.IIS comes as an optional component of most Windows 
operating systems. You can install IIS by usingAdd/Remove Windows Components from Add or 
Remove Programs in the Control Panel. 

• Sun Java System Web Server- Based on the Sun One Web Server, the Sun Java System Web Server is 
designed for medium to large business applications. Sun Java System Web Server is available for most 
operating systems. 

 

 

 

 

 

 

 

Web Browser- A web browser is an interface that helps a computer user gain access to all the content that is 

on the Internet and the hard disk of the computer. It can view images, text documents, audio and video files, 

games, etc. More than one web browser can also be installed on a single computer. The user can navigate 

through files, folders and websites with the help of a browser. When the browser is used for browsing web 

pages, the pages may contain certain links which can be opened in a new browser. Multiple tabs and windows 

of the same browser can also be opened. 

Some popular Web Browsers: 

• Internet Explorer : Internet Explorer (IE) is a product from software giant Microsoft. This is the most 

commonly used browser in the universe 

Difference between Web Server and Application Server 

• A Web server can be either a computer program or a computer running a program that is 

responsible for accepting HTTP requests from clients, serving back HTTP responses along 

with optional data contents, which usually are web pages such as HTML documents and 

linked objects on it.  

• An application server is the kind of software engine that will deliver various applications to 

another device. It is the kind of computer found in an office or university network that 

allows everyone in the network to run software off of the same machine. 



INTERNET AND EMAIL                                                  

7   Email-jkexamcracker@gmail.com 
Contact no. 9469860788 

 

• Safari : Safari is a web browser developed by Apple Inc. and included in Mac OS X. It was first released 

as a public beta in January 2003. Safari has very good support for latest technologies like XHTML, CSS2 

etc. 

• Firefox : Firefox is a browser derived from Mozilla. It was released in 2004 and has grown to be the 

second most popular browser on the Internet. 

• Opera : Opera is smaller and faster than most other browsers, yet it is full- featured. Fast, user-

friendly, with keyboard interface, multiple windows, zoom functions, and more. Ideal for newcomers 

to the Internet, school children, handicap and as a front-end for CD-Rom and kiosks. 

• Google Chrome : This web browser was developed by Google. Its beta and commercial versions were 

released in September 2008 for Microsoft Windows. It has soon become the fourth-most widely used. 

 

 

 

 

 

Domain Name -It is the unique name that identifies an Internet site. Domain Names always have two or more 

parts, separated by dots. The part on the left is the most specific, the part on the right is the most general. A 

given machine can have more than one Domain name but a given Domain Name points to only one machine. 

For example: google.com etc 

Domain abbreviation- Domain are organised by the type of organisations and by country. A three letter 

abbreviation indicating the organisation and usually two letter abbreviation indicating the country name. Most 

common abbreviations for organisation are – 

• .org Organisation 

• .net Network 

• .com Commercial 

• .edu Education 

• .gov Government 

• .mil Military 

Some domain abbreviations for country are : 

• .in India 

• .an Australia 

• .fr France 

• .nz New Zealand 

• .uk United kingdom 

• The first web browser - or browser-editor rather - was called WorldWideWeb as, after all, 

when it was written in 1990 it was the only way to see the web. Much later it was renamed 

Nexus in order to save confusion between the program and the abstract information space 

(which is now spelled World Wide Web with spaces). 

• Hidden Reflex, an Indian startup running since 2008, developed and launched India's first 

web browser entitled 'Epic'. 
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Domain Name System (DNS) - The DNS stores and associates many types of information with domain names, 

but most importantly, it translates domain names (computer host name) to IP address. It also lists mail 

exchange series accepting E-mail for each domain. 

IP ADDRESS- IP address stands for internet protocol address; it is an identifying number that is associated with 

a specific computer or computer network. When connected to the internet, the IP address allows the 

computers to send and receive information. 

There are two versions of IP that currently coexist in the global Internet: IP version 4 (IPv4) and IP version 6 

(IPv6). IP addresses are made up of binary values and drive the routing of all data over the Internet. IPv4 

addresses are 32 bits long, and IPv6 addresses 128 bits long. 

HyperText Markup Language (HTML)- HTML (Hypertext Markup Language) is the set of markup symbols or 

codes inserted in a file intended for display on a World Wide Web browser page. The <html> tag tells the 

browser that this is an HTML document. The <html> tag represents the root of an HTML document. 

Hypertext : Hypertext is a cross referencing tool which connects the links to other text using hyperlinks.  

Hypermedia : Hypermedia is the extension of Hypertext which includes multiple forms of media such as text, 

graphics, audio or video etc rather than only text based like hypertext.  

Hyperlink: The hyperlink contains the URL of the webpages. In a general way, a hyperlink is referenced when a 

hypertext navigated. These hyperlinks are hidden under the text, image, graphics, audio, video, and gets 

highlighted once we hover the mouse over it. 

TYPES OF NETWORKS 

• LAN (Local Area Network) - Can go up to 1 KM radius. A local area network (LAN) is a group of 

computers and associated devices that share a common communications line or wireless link to a 

server. Typically, a LAN encompasses computers and peripherals connected to a server within a 

distinct geographic area such as an office or a commercial establishment. 

• WAN (Wide Area Network) - No Limit. A wide area network (WAN) is a network that exists over a 

large-scale geographical area. A WAN connects different smaller networks, including local area 

networks (LANs) and metro area networks (MANs). This ensures that computers and users in one 

location can communicate with computers and users in other locations. WAN implementation can be 

done either with the help of the public transmission system or a private network. 

• WLAN(Wireless Local Area Network) - A wireless local area network (WLAN) is a wireless computer 

network that links two or more devices using wireless communication within a limited area such as a 

home, school, computer laboratory, or office building. This gives users the ability to move around 

within a local coverage area and yet still be connected to the network. Through a gateway, a WLAN 

can also provide a connection to the wider Internet. 

Most modern WLANs are based on IEEE 802.11 standards and are marketed under the Wi-Fi brand 

name. 

• MAN(Metropolitan Area Network) - A metropolitan area network is a computer network that 

interconnects users with computer resources in a geographic area or region larger than that covered 

by even a large local area network (LAN) but smaller than the area covered by a wide area network 

(WAN). The term is applied to the interconnection of networks in a city into a single larger network 
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(which may then also offer efficient connection to a wide area network). It is also used to mean the 

interconnection of several local area networks by bridging them with backbone lines. The latter usage 

is also sometimes referred to as a campus network. 

• PAN(Personal Area Network)- Personal Area Network is a network arranged within an individual 

person, typically within a range of 10 meters. Personal Area Network is used for connecting the 

computer devices of personal use is known as Personal Area Network. Thomas Zimmerman was the 

first research scientist to bring the idea of the Personal Area Network. Personal Area Network covers 

an area of 30 feet.Personal computer devices that are used to develop the personal area network are 

the laptop, mobile phones, media player and play stations. 

NETWORKING DEVICES ( Hardware) 

Hardware devices that are used to connect computers, printers, fax machines and other electronic devices to a 

network are called network devices. These devices transfer data in a fast, secure and correct way over same or 

different networks. 

 Modem- Modem is a device that enables a computer to send or receive data over telephone or cable 

lines. The data stored on the computer is digital whereas a telephone line or cable wire can transmit 

only analog data. 

The main function of the modem is to convert digital signal into analog and vice versa. Modem is a 

combination of two devices − modulator and demodulator. The modulator converts digital data into 

analog data when the data is being sent by the computer. The demodulator converts analog data signals 

into digital data when it is being received by the computer. 

Types of Modem 

Modem can be categorized in several ways like direction in which it can transmit data, type of 

connection to the transmission line, transmission mode, etc. 

Depending on direction of data transmission, modem can be of these types − 

• Simplex − A simplex modem can transfer data in only one direction, from digital device to 

network (modulator) or network to digital device (demodulator). 

• Half duplex − A half-duplex modem has the capacity to transfer data in both the directions but 

only one at a time. 

• Full duplex − A full duplex modem can transmit data in both the directions simultaneously. 

 Router- A router is a network layer hardware device that transmits data from one LAN to another if 

both networks support the same set of protocols. So a router is typically connected to at least two LANs 

and the internet service provider (ISP). It receives its data in the form of packets, which are data frames 

with their destination address added. Router also strengthens the signals before transmitting them. 

That is why it is also called repeater. 

 Switch- Switch is a network device that connects other devices to Ethernet networks through twisted 

pair cables. It uses packet switching technique to receive, store and forward data packets on the 

network. The switch maintains a list of network addresses of all the devices connected to it. 

On receiving a packet, it checks the destination address and transmits the packet to the correct port. 

Before forwarding, the packets are checked for collision and other network errors. The data is 

transmitted in full duplex mode 

 Hub- A network hub is a device that allows multiple computers to communicate with each other over a 

network. It has several Ethernet ports that are used to connect two or more network devices together. 

Services of Internet 
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• Online banking : Online banking is an electronic payment system that enables customers of a financial 

institution to conduct financial transactions on a website operated by the institution, such as a retail 

bank, virtual bank, credit union or building society. Online banking is also referred as Internet banking, 

e-banking, virtual banking and by other terms. 

• E-commerce : E-commerce (electronic commerce or EC) is the buying and selling of goods and 

services, or the transmitting of funds or data, over an electronic network, primarily the Internet. 

• M-commerce : M-commerce stands for Mobile Commerce wherein commercial transactions are done 

using cellular or mobile phones that have access to the Internet.  

• E-Shopping - (Electronic shopping) : It is the process of buying goods and services from merchants 

who seel an the Internet. some E-shopping websites are flipkart, amazon, jabong etc.  

• E-Reservation (Electronic Reservation) : Electronic Reservation means making a reservation for a 

services via Internet. Example of E-Reservation are - www.irctc.com, www.makingtrip.com etc. Social 

Networking : Social Networking services is an online service, platform or site that focuses on 

facilitating the building of social networks or social relations among people. The most popular sites 

are facebook, Twitter etc. 

• Real time Updates : There are various websites on the internet which provides you with the real 
time updates in every field be it in business, sports, finance, politics, entertainment and others. 
Many a time the decisions are taken on the real time updates that are happening in various parts of 
the world and this is where internet is very essential and helpful. 

• Education : There are a number of books, reference books, online help centres, expert’s views and 
other study oriented material on the internet that can make the learning process very easier as well 
as a fun learning experience. There are lots and lots of websites which are related to different topic. 
You can visit them and can gain endless amount of knowledge that you wish to have. With the use 
of internet for education, you are non-longer dependent on some other person to come and teach 
you. There are various number of tutorials available over the internet using which you can learn so 
many thing very easily. 
 

• E-MAIL- ELECTRONIC MAIL 

 It is the most widely used application on the Internet. It is simple, very fast and a reliable tool for sending 
and receiving messages from an individual or a group of people across the world via the Internet as 
similar to writing a letter. 

 In 1971, Ray Tomlinson created the first ARPANET email application, so he is considered to be the father of 
E-mail. 

Hotmail was the first free email service launched in June 1996 by Sabeer Bhatia. Today, hotmail is still one of 
the biggest free email services. 

E-mail addresses are written with a custom username at the beginning followed by the email service provider's 
domain name, with an @ sign separating the two. Here's an example: name@gmail.com. More plainly, e-mail 
is a message that may contain text, files, images, or other attachments sent through a network to a specified 
individual or group of individuals. 

Writing an e-mail 

When writing an e-mail message, it should look something like the example window below. As you can see, 
several fields are required when sending an e-mail: 
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The To field is where the e-mail address of the person receiving the e-mail is placed. 

The From field should contain your e-mail address. If you are replying to a message, the To: and From: fields 
are automatically filled out. If it's a new message, you'll need to specify the recipients in the To: field by 
selecting them from your contact list or by typing the e-mail addresses. If you enter more than one recipient 
(e.g., group e-mail), the addresses should be separated by a comma and a space, or by pressing the Tab key. 

The Subject should consist of a few words describing the e-mail's contents. The subject lets the recipient see 
what the e-mail is about, without opening and reading the full e-mail. This field is optional. 

The CC ("Carbon Copy") field allows you to specify recipients who are not direct addressees (listed in the "To" 
field). For instance, you can address an e-mail to Jeff and CC Linda and Steven. Although the e-mail is 
addressed to Jeff, Linda and Steven also receive a copy and everyone can see who received the e-mail. This 
field is optional. 

The BCC ("blind carbon copy") field is similar to CC, except the recipients are secret. Each BCC recipient will 
receive the e-mail, but will not see who else received a copy. The addressees (anyone listed in the "To" field) 
remain visible to all recipients. This field is optional. 

Finally, the Message Body is the location you type your main message. It often contains your signature at the 
bottom; similar to a handwritten letter. 

Advantages of e-mail 

There are many advantages of e-mail and the usage of e-mail versus postal mail. Some of the main advantages 
are listed below. 

• Free delivery - Sending an e-mail is virtually free, outside the cost of Internet service. There is no need 
to buy a postage stamp to send a letter. 

• Global delivery - E-mail can be sent to nearly anywhere around the world, to any country. 
• Instant delivery - An e-mail can be instantly sent and received by the recipient over the Internet 
• File attachment - An e-mail can include one or more file attachments, allowing a person to send 

documents, pictures, or other files with an e-mail. 
• Long-term storage - E-mails are stored electronically, which allows for storage and archival over long 

periods of time. 
• Environmentally friendly - Sending an e-mail does not require paper (paperless), cardboard, or 

packing tape, conserving paper resources 
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What is open source software? 

Open source software (OSS) is software that is distributed with its source code, making it available for use, 
modification, and distribution with its original rights. Source code is the part of software that most computer 
users don’t ever see; it’s the code computer programmers manipulate to control how a program or application 
behaves. Programmers who have access to source code can change a program by adding to it, changing it, or 
fixing parts of it that aren’t working properly. OSS typically includes a license that allows programmers to 
modify the software to best fit their needs and control how the software can be distributed. 

What is the history of OSS? 

The idea of making source code freely available originated in 1983 from an ideological movement informally 
founded by Richard Stallman, a programmer at MIT. Stallman believed that software should be accessible to 
programmers so they could modify it as they wished, with the goal of understanding it, learning about it, and 
improving it.i Stallman began releasing free code under his own license, called the GNU Public License. This 
new approach and ideology surrounding software creation took hold and eventually led to the formation of 
the Open Source Initiative in 1998. 

Open Source Initiative- The Open Source Initiative (OSI) was created to promote and protect open source 
software and communities.ii In short, the OSI acts as a central informational and governing repository of open 
source software. It provides rules and guidelines for how to use and interact with OSS, as well as providing 
code licensing information, support, definitions, and general community collaboration to help make the use 
and treatment of open source understandable and ethical. 

Examples of Open source softwares- 

 GNU/Linux 

 Mozilla Firefox 

 VLC media player 

 SugarCRM 

 GIMP- GNU Image Manipulation Program. 

 VNC- Virtual Network Computing, or VNC, is an open source application that provides screen 
sharing services and is available for virtually all operating systems such as Windows, Linux, and of 
course OS X.  

 Apache web server 

 LibreOffice 

 jQuery 

 Linux operating system. 

 Android by Google. 

 Open office. 

 Firefox browser. 

 Moodle- Learning Platform or course management system (CMS) - a free Open Source software 
package designed to help educators create online courses. 

 ClamWinantivirus. 

 WordPress content management system. 

 MySql-reely downloadable version of the world's most popular open source database.  

 Magento 
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 Audacity 

 Thunderbird Email client. 

 Php scripting language. 

 Blender- It is a 3D graphics and animation tool that supports motion tracking, simulation, 
animation, video editing, rendering, modeling and much more.  

 Python- is common programming and scripting language used by custom software developers. 

 Shotcut- a video editor that offers powerful features including audio and webcam capture, color, 
text, noise, and counter generators, support of popular image formats, EDL export and much 
more.  

Difference between Open Source Software and Closed Source Software : 

S.No. OPEN SOURCE SOFTWARE CLOSED SOURCE SOFTWARE 

01. 

Open source software refers to the 
computer software which source is 
open means the general public can 
access and use. 

Closed source software refers to the 
computer software which source code is 
closes means public is not given access 
to the source code. 

02. 
Open Source Software in short also 
referred as OSS. 

Closed Source Software in short also 
referred as CSS. 

03. 
The source code of open source 
software is public. 

In closed source software the source 
code is protected. 

04. 

This code can be modified by other 
users and organizations means that 
the source code is available for 
anyone to look at. 

The only individual or organization who 
has created the software can only 
modify the code. 

05. 
The price of open source software is 
very less. 

The price of closed source software is 
high. 

06. 

There is no so much restrictions on 
users based on usability and 
modification of software. 

There is so much restrictions on users 
based on usability and modification of 
software. 

07. 
Programmers compete with each 
other for recognition. 

Programmers do not compete with each 
other for recognition. 

08. 

Programmers freely provide 
improvement for recognition if their 
improvement is accepted. 

Programmers are hired by the software 
firm/organization to improve the 
software. 

09. 
If the program is popular then very 
large number of programmers may 

There is a limitation on the number of 
programmers/team who will work on 
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work on the project. the project. 

10. It is purchased with its source code. It is not purchased with its source code. 

11. 
Open software can be installed into 
any computer. 

Closed software needs have a valid 
license before installation into any 
computer. 

12. 
Open source software fails fast and 
fix faster. 

Closed source software has no room for 
failure. 

13. 
In closed source software no one is 
responsible for the software. 

In closed source software the vendor is 
responsible if anything happened to 
software. 

14. 

Examples are Firefox, OpenOffice, 
Gimp, Alfresco, Android, Zimbra, 
Thunderbird, MySQL, Mailman, 
Moodle, TeX, Samba, Perl, PHP, KDE 
etc. 

Examples are Skype, Google earth, Java, 
Adobe Flash, Virtual Box, Adobe Reader, 
Microsoft office, Microsoft Windows, 
WinRAR, mac OS, Adobe Flash Player 
etc. 

 

Advantages 

1. Open source software is free. 
2. Open source is flexible; developers can examine how the code works and freely make changes to 

dysfunctional or problematic aspects of the application to better fit their unique needs. 
3. Open source is stable; the source code is publicly distributed, so users can depend on it for their 

long-term projects since they know that the code’s creators cannot simply discontinue the project 
or let it fall into disrepair. 

4. Open source fosters ingenuity; programmers can use pre-existing code to improve the software and 
even come up with their own innovations. 

5. Open source comes with a built-in community that continuously modifies and improves the source 
code. 

6. Open source provides great learning opportunities for new programmers. 

Disadvantages 

1. Open source can be harder to use and adopt due to difficulty setting it up and the lack of friendly 
user interfaces. 

2. Open source can pose compatibility issues. When attempting to program proprietary hardware 
with OSS, there is often a need for specialized drivers that are typically only available from the 
hardware manufacturer.   

3. Open source software can pose liability issues. Unlike commercial software, which is fully controlled 
by the vendor, open source rarely contains any warranty, liability, or infringement indemnity 
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protection. This leaves the consumer of the OSS responsible for maintaining compliance with legal 
obligations. 

4. Open source can incur unexpected costs in training users, importing data, and setting up required 
hardware. 

PRACTICE QUESTIONS 

1. Which of the following is not an open 
source software? 

a) LibreOffice 
b) Microsoft Office 
c) GNU image manipulation 
d) MySQL 

ANS-B 

2. OSI stands for? 
a) Open Source Index 
b) Open Source Image 
c) Open Source Initiative 
d) Open Source Instant 

ANS-C 

3. Who was the founder of Linux? 
a) Linus Torvalds 
b) IBM 
c) Christopher Markin 
d) Bill Gates 

ANS-A 

4. Which of the following is the most 
famous example of open source 
software? 

a) Microsoft Windows 
b) Mac OS X 
c) UNIX 
d) Linux 

ANS-D 

5. What is another name given to 
'proprietary software'? 

a) Open source software 
b) Bespoke software 
c) Tailor Made software 
d) Closed source software 

ANS-D 

6. Which of the following is an advantage 
of 'open source' software? 

a) You can edit the source code to 
customise it 

b) You need to be an expert to edit code 
c) You have to pay 
d) Can sometimes be too generic for 

specialist purposes 

ANS-A 

7. What is an Open Source Software? 
a) Computer software for which the source 

code is made available for users. 
b) Practice of distributing software under 

two or more different terms and 
conditions. 

c) Distribution strategy of business 
software. 

d) A single software product available 
under two different licenses. 

ANS-A 

8. The open source definition is based on 
the _______________. 

a) software license. 
b) free software foundation. 
c) debian free software guidelines. 
d) open source initiative. 

ANS-D 

9. Developing open source software can 
mean _____________. 

a) basing it on open source technologies 
and open standards. 

b) working collaboratively with other 
groups. 
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c) to redistribute the source code widely. 
d) to use the source code widely. 

ANS-C 

 
10. An image editor similar to Adobe 

photoshop is 
a) Nvu 
b) Open office 
c) Bluefish 
d) GIMPshop 

ANS-D 

11. The users must agree to 
the___________ terms and agreements 
when they use an open source 
software. 

a) system 
b) license 
c) community 
d) programmer 

ANS-D 
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What is an Operating System? 

 A program that acts as an intermediary between a user of a computer and the computer hardware.  

 An operating System is a collection of system programs that together control the operations of a 
computer system. 

Some examples of operating systems are UNIX, Mach, MS-DOS, MS-Windows, Windows/NT, Chicago, OS/2,  
MacOS, VMS, MVS, and VM. 

Operating system goals: 

• Execute user programs and make solving user problems easier. 
• Make the computer system convenient to use. 
• Use the computer hardware in an efficient manner. 

Computer System Components 

1. Hardware – provides basic computing resources (CPU, memory, I/O devices). 
2. Operating system – controls and coordinates the use of the hardware among the various 

application programs for the various users. 
3. Applications programs – Define the ways in which the system resources are used to solve the 

computing problems of the users (compilers, database systems, video games, business programs). 
4. Users (people, machines, other computers). 

Abstract View of System Components 

 

Operating System Definitions 

• Resource allocator – manages and allocates resources. 
• Control program – controls the execution of user programs and operations of I/O devices . 
• Kernel – The one program running at all times (all else being application programs). 

Components of OS: OS has two parts. (1)Kernel.(2)Shell. 

1. Kernel is an active part of an OS i.e., it is the part of OS running at all times. It is a programs which 
can interact with the hardware. Ex: Device driver, dll files, system files etc. 

2. Shell is called as the command interpreter. It is a set of programs used to interact with the 
application  programs. It is responsible for execution of instructions given to OS (called commands). 
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Operating systems can be explored from two viewpoints: the user and the system. 

1. User View: From the user’s point view, the OS is designed for one user to monopolize its resources, 
to maximize the work that the user is performing and for ease of use. 

2. System View: From the computer's point of view, an operating system is a control program that 
manages the execution of user programs to prevent errors and improper use of the computer. It is 
concerned with the operation and control of I/O devices. 

Functions of Operating System(OS): 

Main functions of the operating system are as follows: 

 Memory Management 

 Process Management 

 Device Management 

 File Management 

 Protection and Security 

 User interface or Command interpreter. 

 

Memory Management: 

The activities of memory management handled by OS are: 

 Allocate memory 

 Free Memory 

 Re-allocate memory to a program when a used block is freed 

 Keep track of memory usage. 
 

Process Management: 

The activities of process management handled by OS are: 

 Control access to shared resources like file, memory I/O and CPU 

 Control execution of applications 

 Create, execute and delete a process 

 Cancel or resume a process 

 Schedule a process 

 Synchronization, communication and deadlock handling for process 

Device Management: 

The activities of device management task handled by OS are: 

 Open, close and write device drivers. 
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 Communication, control and monitor the device drivers.Prof. K. Adisesha (Ph.D.)  

File Management: 

The activities of file management task handled by OS are: 

 Create and delete both files and directories 

 Provide access to files 

 Allocate space for files 

 Keep back-up of files 

 Secure files 

Protection and Security: 

 OS protects the resource of system. 

 User authentication, file attributes like read, write, encryption and back-up of data are used by OS 
to provide basic protection. 

User Interface or Command Interpreter: 

 OS provides an interface between the user and the computer hardware. 

 The user interface is a set of commands or a Graphical User Interface via which the user  interacts 
with the application and the hardware. 

Different Operating Systems 

1. MS-DOS: 

MS-DOS which is short for Microsoft Disk Operating System is a non-graphical command line operating system 
developed for IBM compatible computers with x86 microprocessor. The operating system used a command 
line interface for the user to input commands to navigate, open and manipulate files on their computer. 

2. Windows Operating System: 

Windows is an operating system designed by Microsoft to be used on a standard x86 Intel and AMD 
processors. It provides an interface, known as a graphical user interface(GUI) which eliminates the need to 
memorize commands for the command line by using a mouse to navigate through menus, dialog boxes, 
buttons, tabs, and icons. The operating system was named windows since the programs are displayed in the 
shape of a square. This Windows operating system has been designed for both a novice user just using at 
home as well as for professionals who are into development. 

3. LINUX Operating System: 

The Linux OS is an open source operating system project that is a freely distributed, cross-platform operating 
system developed based on UNIX. This operating system is developed by Linus Torvalds. The name Linux 
comes from the Linux kernel. It is basically the system software on a computer that allows apps and users to 
perform some specific task on the computer. The development of Linux operating system pioneered the open 
source development and became the symbol of software collaboration. 
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4. Solaris Operating System: 

Solaris or SunOS is the name of the Sun company’s Unix variant operating system that was originally developed 
for its family of Scalable Processor Architecture-based processors (SPARC) as well as for Intel-based processors. 
The UNIX workstation market had been largely dominated by this operating system during its time. As the 
Internet grew Sun’s Solaris systems became the most widely installed servers for Web sites. Oracle purchased 
Sun and later renamed to Oracle Solaris. 

5. Android Mobile Operating System: 

Android is a Google’s Linux based operating system it is designed primarily for touch screen mobile devices 
such as smart phones and tablet computers. The hardware which can be used to support android is based on 
three architectures namely ARM, Intel and MIPS design lets users manipulate the mobile devices intuitively, 
with finger movements that mirror common motions, such as pinching, swiping, and tapping making these 
applications comfortable for the users. 

6. iOS Mobile Operating System: 

iOS which is short for iPhone OS is a mobile operating system created and developed by Apple Inc. exclusively 
for its hardware like A12 Bionic chip that presently powers many of its mobile devices, including the iPhone, 
iPad, and iPod. The iOS user interface is based upon using multi-touch gestures such as swipe, tap, pinch, and 
reverse pinch. The purpose of these finger actions is to provide the user with fast responsive inputs given from 
multiple fingers to the multi-touch capacitive screen display. 

7. UNIX Operating System: 

UNIX is an operating system which was first developed in the 1960s, and has been under constant 
development ever since. By operating system, we mean the suite of programs which make the computer work. 
It is a stable, multi-user, multi-tasking system for servers, desktops and laptops. 

UNIX systems also have a graphical user interface (GUI) similar to Microsoft Windows which provides an easy 
to use environment. However, knowledge of UNIX is required for operations which aren't covered by a 
graphical program, or for when there is no windows interface available, for example, in a telnet session. 

 

Types of Operating System(OS): 

The different types of operating system are: 

 Single user Operating System 

 Batch Operating System 

 Multiprogramming Operating System 

 Multitasking Operating System 

 Multiuser Operating System 

 Time sharing System (Online /Multiuser) 

 Real time system 

 Distributed Operating System 
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 Network Operating System 

 

1. Single User Operating System: 

 This OS allows only one user to share the system resource including the CPU. 

 These are mainly the operating system configured for the use of desktop PC and laptops. 

 DOS and Windows- 95, Win-98, Apple Macintosh etc are example.  
 

2. Batch Operating System: 

 Batch is defined as a group of job with similar needs and similar resource requirements. 

 The operating system that allows users to create batches and execute each batch sequentially, 
processing all jobs of batch considering them as a single process is called “Batch Operating system” 

 It allows litter or no interaction between users and executing programs. 

 This is well suited for applications with large computation time and no user interaction. 

 Payroll, forecasting, statistical analysis are programs example for its usage. 

Advantages: 

 User need not wait during its execution. 

 It will function in FIFO (First In First Out) order. 

Disadvantages: 

 Non-interactive mode of execution 

 Offline debugging 

 IBM System/360 Operating system is an example for Batch Operating system 

 In DOS, we can emulate the batch processing using .BAT file. 
 

3. Multiprogramming Operating System: 

 Multiprogramming is the capability of CPU to execute two or more programs concurrently. 

 Two or more programs are stored concurrently in primary storage, and the CPU moves from one 
program to another, partially executing each in turn. 

 Early computer system and many personal computers execute program in the order in which it is 
read into the system. Only one program is executed at a time.  
 

4. Multitasking Operating System: 

 Multitasking operating systems allow more than one program to run at a time. 

 In gives you the perception of 2 or more tasks running at the same time. It does this by dividing 
system resources amongst these tasks. 

 Multitasking is usually implemented by code and data of several programs in memory 
simultaneously and multiplexing processor and I/O device among them. 

 Multitasking is also called context switching. 

 Multitasking usually refers to a single user. 

 Example: Windows 98 
5. Multi-user Operating System: 

 A multi-user operating system allows multiple users on different computers or terminal to access a 
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single system with one OS on it. 

 It creates and maintains individual user environments, individual authentication and security level 
privileges, provides per user resource usage accounting. 
 

6. Time-Sharing Operating System: 

 Time-Sharing operating system allows many users to share the computer resource simultaneously. 

 Time sharing refers to the allocation of computer resource in time slots to several programs 
simultaneously. 

 Large CAD and text processing systems belong to timesharing OS. 

 Most of the time-sharing operating systems adopted time slicing/ round robin scheduling 
algorithm. Each user/process will receive a portion of the time slot. 

 UNIX, Windows Server is the example for multiprogramming, multi-use and time sharing systems. 
 

7. Real-time Operating System: 

 Real time systems refer to a computer and software systems that respond to events before the 
events become obsolete. 

 The primary objective of real-time systems is to provide quick event – response times and thus 
meeting the scheduling deadlines. 

 The main applications where real time systems are used include medical imaging systems, industrial 
control systems, flight control and military application. 

 Windows CE, Symbian, Linux OS are example for real-time systems.  
 

8. Distributed Operating System: 

 A distributed operating system is a collection of autonomous computer systems capable of 
communication and cooperation via the software and hardware interconnections. 

 For example: if we have ‘N’ systems in a distributed environment then the distributed OS helps us 
in balancing the load by sharing processors, I/O devices etc. 

 The ATM centers of a bank are example of distributed operating system. 
 

9. Network Operating System: 

 A network operating system is a collection of software and associated protocols that allow a set of 
autonomous computer which are interconnected by a computer network. 

 It can be used in a convenient and cost-effective manner. 

 In a network operating system the user are aware of the existence of multiple computers and can 
log in to remote machines and copy files from one machine to another machine. 

 Windows NT, windows server, LINUX are example. 
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SOME IMPORTANT CONCEPTS RELATED TO OPERATING SYSTEM  

 Threads: 

A thread is a lightweight process or sub-process and forms the basic unit of CPU utilization. A process can 
perform more than one task at the same time by including multiple threads. 

There are two types of threads: 

• User threads 
• Kernel threads 

User threads are implemented by users. OS doesn’t recognize user level threads. 

kernel threads are implemented by OS. Kernel threads are recognized by OS. 

 Process: 

A process is a program under execution. Each process is represented by a Process Control Block (PCB). 

 Process Scheduling: Below are different times with respect to a process. 
1. Arrival Time – Time at which the process arrives in the ready queue. 
2. Completion Time – Time at which process completes its execution. 
3. Burst Time – Time required by a process for CPU execution. 
4. Turn Around Time – Time Difference between completion time and arrival time. 

Turn Around Time = Completion Time - Arrival Time  
5. Waiting Time (WT) – Time Difference between turn around time and burst time. 

Waiting Time = Turn Around Time - Burst Time  
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 PROCESS SCHEDULING: A typical process involves both I/O time and CPU time. In a 
uniprogramming system like MS-DOS, time spent waiting for I/O is wasted and CPU is free during 
this time. In multiprogramming systems, one process can use CPU while another is waiting for I/O. 
This is possible only with process scheduling. 

Different Scheduling Algorithms: 

1. First Come First Serve (FCFS) : Simplest scheduling algorithm that schedules according to 
arrival times of processes. 

2. Shortest Job First (SJF): Process which have the shortest burst time are scheduled first. 
3. Shortest Remaining Time First (SRTF): It is preemptive mode of SJF algorithm in which jobs 

are scheduled according to the shortest remaining time. 
4. Round Robin (RR) Scheduling: Each process is assigned a fixed time, in cyclic way. 
5. Priority Based scheduling (Non Preemptive): In this scheduling, processes are scheduled 

according to their priorities, i.e., highest priority process is schedule first. If priorities of two 
processes match, then scheduling is according to the arrival time. 

6. Highest Response Ratio Next (HRRN): In this scheduling, processes with highest response 
ratio is scheduled. This algorithm avoids starvation. 
Response Ratio = (Waiting Time + Burst time) / Burst time 

6. Multilevel Queue Scheduling (MLQ): According to the priority of process, processes are 
placed in the different queues. Generally high priority process are placed in the top level 
queue. Only after completion of processes from top level queue, lower level queued 
processes are scheduled. 

7. Multi level Feedback Queue (MLFQ) Scheduling: It allows the process to move in between 
queues. The idea is to separate processes according to the characteristics of their CPU bursts. 
If a process uses too much CPU time, it is moved to a lower-priority queue. 

 

 The Critical Section Problem 
• Critical Section is the part of a program which tries to access shared resources. That resource may 

be any resource in a computer like a memory location, Data structure, CPU or any IO device. 
• The critical section cannot be executed by more than one process at the same time; operating 

system faces the difficulties in allowing and disallowing the processes from entering the critical 
section. 

In order to synchronize the cooperative processes, our main task is to solve the critical section problem. We 
need to provide a solution in such a way that the following conditions can be satisfied. 

1. Mutual Exclusion 

By Mutual Exclusion, we mean that if one process is executing inside critical section then the other process 
must not enter in the critical section. 

2. Progress 

Progress means that if one process doesn't need to execute into critical section then it should not stop other 
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processes to get into the critical section. 

3. Bounded Waiting 

We should be able to predict the waiting time for every process to get into the critical section. The process 
must not be endlessly waiting for getting into the critical section. 

 Deadlock: 

A situation where a set of processes are blocked because each process is holding a resource and waiting for 
another resource acquired by some other process. Deadlock can arise if following four conditions hold 
simultaneously (Necessary Conditions): 

1. Mutual Exclusion – One or more than one resource are non-sharable (Only one process can 
use at a time). 

2. Hold and Wait – A process is holding at least one resource and waiting for resources. 
3. No Preemption – A resource cannot be taken from a process unless the process releases the 

resource. 
4. Circular Wait – A set of processes are waiting for each other in circular form. 

Methods for handling deadlock: There are three ways to handle deadlock 

1. Deadlock prevention or avoidance: The idea is to not let the system into deadlock state. 
2. Deadlock detection and recovery : Let deadlock occur, then do preemption to handle it once 

occurred. 
3. Ignore the problem all together – : If deadlock is very rare, then let it happen and reboot the 

system. This is the approach that both Windows and UNIX take. 

 
PETERSON’S SOLUTION FOR CRITICAL SECTION PROBLEM 

Peterson's Solution is a classical software based solution to the critical section problem. 

Peterson's algorithm is a concurrent programming algorithm developed by Gary L. Peterson in a 1981 
paper. It is known as a simple algorithm when compared to others. Peterson's algorithm is used for 
mutual exclusion and allows two processes to share a single-use resource without conflict. It uses only 
shared memory for communication. Peterson's formula originally worked only with two processes, but 
has since been generalized for more than two. 
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FIRMWARE- Firmware is data that is stored on a computer or other hardware device's ROM (read-only 
memory) that provides instruction on how that device should operate. Unlike normal software, firmware 
cannot be changed or deleted by an end-user without using special programs, and remains on that device 
whether it's on or off. 

Ascher Opler coined the term "firmware" in a 1967 Datamation article. 

STORAGE MEDIA FOR FIRMWARE 

Originally, firmware was strictly written on ROM chips. That allowed it to be cheap to manufacture and 
ensured it did not get deleted or tampered with. 

Programmable Read-Only Memory (PROM) chips were also used and allowed for a wider array of firmware. 
But using ROM and PROM to store firmware means that when a device's firmware becomes outdated, it 
cannot be updated, only replaced. 

As technology advanced more rapidly, firmware started becoming outdated sooner, before the hardware got 
worn down. Manufacturers then switched to using Erasable Programmable Read-Only Memory (EPROM) 
chips, which allowed for firmware updates. But since EPROM chips were expensive to manufacture and time-
consuming to program and update, firmware eventually evolved to flash memory chips, as they are cheap and 
easy to write and rewrite on. 

Depending on where it is stored and the complexity of its functionality, firmware has three levels: 

1. Low Level Firmware: This level of firmware is stored on non-volatile memory chips such as ROM, PROM—
also known as One-Time Programmable (OTP) memory—and Programmable Logic Array (PLA) structures. 
Because low level firmware is often stored on read-only chips that cannot be rewritten or updated, it is 
considered an intrinsic part of the hardware. 

2. High Level Firmware: This firmware is used with flash memory chips to allow for updates. It often has more 
complex instructions than low level firmware, making it closer to software than hardware. 

3. Subsystems: A subsystem is a device or unit that is a semi-independent part of a larger system. Because this 
firmware level has its microcode embedded in flash chips, CPUs, and LCD units, and is similar to high level 
firmware, it often resembles its own device. 

TYPES OF FIRMWARE 

1. BIOS- Basic Input/Output System (BIOS) is a type of Firmware used during the booting process (power-
on/start up) on IBM PC compatible computers. It can interact with the hardware and check for any unknown 
errors. It then signals another program called bootloader which does the job of waking up the operating 
system sleeping inside the hard drive and put it in the random access memory. So, BIOS is primarily 
responsible for handling your computer’s hardware components and ensure that they function properly. 
Although good, the low-level software has remained almost unchanged for the last two decades, and because 
of this, it is now becoming outdated and un-supportive of modern technologies. For instance, BIOS still uses 
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16-bit code while most laptops and PCs run 32 and 64-Bit code. 

2. UEFI-   EFI-Extensible Firmware Interface (DEVELOPED BY INTEL) , also referred to as Unified Extensible 
Firmware Interface (UEFI) has certain advantages over BIOS. It is a specification for a new generation of 
system firmware that provides the first instructions used by the CPU to startup hardware and passes the 
control to the bootloader. It supports 32 and 64 bit processor. For instance, it helps ensure that your PC boots 
using only software that is trusted by the PC manufacturer, i.e., it supports a feature called ‘Secure Boot’ to 
improve security. 

HUMANWARE 

“Humanware is defined in IT as hardware or software that is built around user capabilities and user needs. This 
often involves creating a particular visual or physical interface for a given set of users. The design and 
engineering of humanware starts with the user's interests and needs first, and designs the infrastructure 
accordingly.” 

 Humanware is the method of adding a human facet into the development of computer programs. The 
main goal of developing humanware is to make hardware and software as functional as possible. The 
philosophy behind humanware is that instead of starting with an implementation goal, the software or IT 
architecture design process starts with an understanding of what users will need. 

A computer system is made up of three major components—hardware, software, and humanware. While 
software and hardware make up an actual computer, humanware is necessary for enhancing user experience 
(UX) by making improvements in the system’s user interface (UI). Humanware is the combination of hardware 
and software elements that make human interaction with a device as good as possible. Often, developing 
humanware begins by defining who the computer’s potential users are, what they are interested in, and what 
they need before designing the infrastructure. 

The process of building humanware generally consists of these steps: 

 Step 1: Defining Users and Their Capabilities 
To understand what user capabilities must be present in a product, the development team must first 
identify their target users. That may require as many details as possible to address many needs. These 
details include demographics (age, location, career, familial status, etc.), motivations (mindset, power, 
incentivization, fears, etc.), previous product experience, and everything else that helps developers get 
to know target users. 
This first step is often the most crucial. It takes some time to finish because developers need to be as 
exhaustive as possible. It also requires considering how customers will evolve. 

 Step 2: Specifying Usability Objectives 
Using the target users and their needs as pegs, the development team then needs to come up with 
goals. This step requires developers to think of all possible humanware capabilities they can integrate 
into the system they are building. If possible, all these objectives must be measurable for future 
improvements. 

 Step 3: Building a Prototype 
The next step is building a prototype. This device will allow developers to test if the product can indeed 
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meet the goals they set. It involves asking actual users to test the prototype. The development team 
gets user feedback and incorporates suggestions or recommendations into the current design to 
address flaws. The prototype should undergo various testing cycles until the product passes quality and 
usability testing. 

 Step 4: Get feedback from users and continually improve the product. 

Practice Qusetions 

1. The software substituted for 
hardware and stored in ROM. 

a) Synchronous Software 
b) Package Software 
c) Firmware 
d) Middleware 

ANS-C 

 

2. Storage of firmware is ___________ 
a) Cache Memory 
b) RAM 
c) External 
d) ROM 

ANS-D 

 

3. Computer firmware  is present in 
a) volatile memory 
b) non- volatile memory 
c) Cache memory 
d) RAM 

ANS-B 

 

4. Which of the following is related to 
the people or professionals working 
in a computer center? 

a) Software 
b) hardware 
c) firmware 
d) humanware 

ANS-D 

 

5. BIOS and ROM chips are called 
a) software 
b) hardware 
c) firmware 
d) Booting 

ANS-C 

 

6. ____________ are stored in the 
permanant memory of a system at 
the time of manufacturing of a 
digital device. 

a) Software 
b) firmware 
c) hardware 
d) ROM  

ANS-B 

 

7. The________is firmware that 
contain a computer’s startup 
instruction. 

a) POST 
b) BIOS 
c) CMOS 
d) DIOS 

ANS-B 

 

8. Fullform of UEFI 
a) United Extensible Firmware 

Interface 
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b) Unified Extensible Firmware 
Interface 

c) Universal Extensible Firmware 
Interface 

d) None of these. 
B 

 

9. Bios supports 
a) 16 bit processor 
b) 32 bit processor 
c) 64 bit processor 
d) none of these. 

ANS-A 

 

10. Which one is not an example of 
Firmware 

a) Traffic lights 
b) Digital watch 
c) Mobile phones 
d) Programmers 

ANS-D 

 

11. The personnel which are related to 
installation, maintenance, operation 
and testing of a computer are called  

a) humanware 
b) Firmware 
c) software 
d) CPU 

ANS-A 
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The Portable Document Format (PDF) is a file format developed by Adobe in the 1990s to present 
documents, including text formatting and images, in a manner independent of application software, 
hardware, and operating systems. 

PDF (Portable Document Format) is a file format that has captured all the elements of a printed 
document as an electronic image that you can view, navigate, print, or forward to someone else. PDF 
files are created using Adobe Acrobat , Acrobat Capture, or similar products. To view and use the files, 
you need the free Acrobat Reader, which you can easily download. Once you've downloaded the 
Reader, it will start automatically whenever you want to look at a PDF file. 

Adobe’s Acrobat Reader is the official tool for reading PDFs. It’s free, and it’s available for Windows, 
macOS, iOS, and Android. 

The latest version of  PDF Reader is known as Acrobat Reader DC.(VERSION 15.0) 

WHO INVENTED PDF? 

In 1991, Adobe co-founder Dr. John Warnock launched the “paper-to-digital revolution” with an idea he 
called, The Camelot Project. The goal was to enable anyone to capture documents from any application, 
send electronic versions of these documents anywhere, and view and print them on any machine. By 
1992, Camelot had developed into PDF. Today, it is the format trusted by businesses around the world. 

 Adobe Systems made the PDF specification available free of charge in 1993. In the early years 
PDF was popular mainly in desktop publishing workflows, and competed with a variety of 
formats such as DjVu, Envoy, Common Ground Digital Paper, Farallon Replica and even 
Adobe's own PostScript format. 
 

 PDF was a proprietary format controlled by Adobe until it was released as an open standard 
on July 1, 2008, and published by the International Organization for Standardization as ISO. 
ISO is also in charge of updating and developing future versions. 
 
Opening PDF files 
Opening and viewing a PDF file is pretty simple. Most modern web browsers will open PDF 
files directly in your browser window instead of downloading them to your computer. If your 
browser can't do this, it should prompt you to download the file instead. Try clicking this link 
to see how it works on your computer. 
 
If your computer uses Windows 7 or earlier, you may need to download a free PDF viewer 
(such as Adobe Reader) before you can view PDF files. 

10 Best PDF Readers . 

1. Adobe Acrobat Reader DC 
2. SumatraPDF 
3. Expert PDF Reader 
4. Nitro Reader 
5. Foxit Reader 
6. Google Drive 
7. Web Browser 
8. Slim PDF 
9. Javelin PDF Reader 
10. PDF-XChange Editor 
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Editing PDF files 

As we mentioned earlier, PDFs are primarily meant for viewing, not editing. However, there 
may be times when you encounter a PDF that allows you to enter certain information, like 
name and address. These PDFs use a special feature called form fields, which allow you to 
type new information into the document and save your changes. 
 
 
PDF advantages 

 Graphic integrity 
A PDF displays the exact same content and layout no matter which operating system, device 
or software application it is viewed on. 
 

 Multi-dimensional 
The PDF format allows you to integrate various types of content – text, images and vector 
graphics, videos, animations, audio files, 3D models, interactive fields, hyperlinks, and 
buttons. All of these elements can be combined within the same PDF file and organized as a 
report, a presentation or a portfolio. 
 

 Convenient 
PDFs are easy to create, read and use by everyone. 
 

 Secure 
Offers options to set up different levels of access to protect the content and the whole 
document, such as watermarks, passwords or digital signatures. 
 
 
 
 

PDF Limitations 

 The PDF was developed as an exchange format for documents. The original goal was to 
preserve and protect the content and layout of a document - no matter what platform or 
computer program it is viewed on. This is why PDFs are hard to edit and sometimes even 
extracting information from them is a challenge. 
 

 Absolutely all programs for editing PDF files are paid, free analogues allow only reading. 
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Computer security (also known as cyber security or IT security) is information security as applied to 
computing devices such as computers and smart phones, as well as computer networks such as private 
and public networks,including the whole Internet. 

Traditionally, computer facilities have been physically protected for three reasons: 

• To prevent theft of or damage to the hardware 
• To prevent theft of or damage to the information 
• To prevent disruption of service  

The Basic Components of Security 

1. Confidentiality : Confidentiality is the concealment of information or resources. The need for keeping 
information secret arises from the use of computers in sensitive fields such as government and industry. 
For example, military and civilian institutions in the government often restrict access to information to 
those who need that information. The first formal work in computer security was motivated by the 
military’s attempt to implement controls to enforce a “need to know” principle. This principle also applies 
to industrial firms, which keep their proprietary designs secure lest their competitors try to steal the 
designs. As a further example, all types of institutions keep personnel records secret. 

2. Integrity : Integrity refers to the trustworthiness of data or resources, and it is usually phrased in terms 
of preventing improper or unauthorized change. Integrity includes data integrity (the content of the 
information) and origin integrity (the source of the data, often called authentication). The source of the 
information may bear on its accuracy and credibility and on the trust that people place in the information. 
This dichotomy illustrates the principle that the aspect of integrity known as credibility is central to the 
proper functioning of a system. 

3. Availability : Availability refers to the ability to use the information or resource desired. Availability is an 
important aspect of reliability as well as of system design because an unavailable system is at least as bad 
as no system at all. The aspect of availability that is relevant to security is that someone may deliberately 
arrange to deny access to data or to a service by making it unavailable. 

4. Access Control System : Any system designed to prevent and restrict access to users. For example, a 
primary form of access control is only allowing users who have accounts to login to a system or only 
allowing the user access to files he or she should be able to see. 

 

 

Malware or malicious software typically consists of code developed by cyber attackers, designed to cause 
extensive damage to data and systems or to gain unauthorized access to a network. Malware is typically 
delivered in the form of a link or file over email and requires the user to click on the link or open the file to 
execute the malware. 

Types of malware can include computer viruses, worms, Trojan horses , root kits, adware and spyware. 

VIRUS - A computer virus is a type of computer program that, when executed, replicates itself by 
modifying other computer programs and inserting its own code. When this replication succeeds, the 
affected areas are then said to be "infected" with a computer virus. 

Transport Layer Security- Transport Layer Security (TLS) is a protocol that ensures privacy 

between communicating applications and their users on the Internet. 
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The terms "virus" and "malware" are often used interchangeably. Malware is a catch-all term for any type 
of malicious software, regardless of how it works, its intent, or how it's distributed. A virus is a specific 
type of malware that self-replicates by inserting its code into other programs. 

“VIRUS: Vital Information Resources Under Seize” 

Top Some Sources of Computer Virus Attack 

1. Downloadable Programs : Downloadable files are one of the best possible sources of virus. Any type of 
executable program including games, freeware, screen savers as well as executable files are one of the 
major sources of computer virus attacks. Executable files having an extension of “.com”, “.exe” and 
“coolgame.exe” contain virus sources too. If in the case a user want to download programs from the 
internet then it is necessary to scan every program before downloading them. 

2. Illegal Software : Most people who download cracked and illegal versions of software online are 
unaware about the reality that they may contain virus sources as well. Such illegal files contain viruses and 
bugs that are difficult to detect as well as to remove. Hence, it is always a preferable option to download 
software from the appropriate source. 

3. Email Attachments : Email attachments are one of the other popular sources of computer virus attacks. 
Hence, a user must handle email attachments with extreme care, especially if the email comes from an 
unknown sender. Installation of a good antivirus assumes prime necessity if one desires to eliminate the 
possibility of virus attacks. 

4. Using Internet : Using internet is one of the common sources of virus infection. Majority of all computer 
users are unaware as when viruses attack computer systems. Almost every computer user click/download 
everything that comes their way and hence unknowingly invites the possibility of virus attacks. 

5. Booting from Unknown CD : Most computer users believe that one of the most common ways of virus 
infection is through Data CD. It is a good practice to remove the CD when the computer system is not 
working. If you do not remove the CD after switching off the computer system then it is every possibility 
that the computer system may start to boot automatically from the disc. 

6. Using Pendrive/USB Flash drive : Using pen drive/USB flash drive is another source of virus attacks. It is 
a good practice to scan the pendrive when it is connected to computer. 

7. Not running the latest updates : Many of the updates, especially those associated with Microsoft 
Windows and other operating systems and programs, are security updates. Running a program or 
operating system that is not up-to-date with the latest updates can be a big security risk and can be a way 
your computer becomes infected. 

HISTORY OF VIRUS 

 Creeper, named for a character on the “Scooby Doo” cartoon show, is generally recognized at 
the first computer virus. It was written in 1971 by Bob Thomas of BBN Technologies and spread 
through DEC PDP-10 computers on ARPANET, displaying the message, "I'm the creeper, catch 
me if you can!" 

 Elk Cloner, written in 1982 by then-15-year-old Rich Skrenta of Pittsburgh, was a boot-sector 
virus designed to infect Apply II computers. 
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 Brain, created in Pakistan in 1986, by two brothers Basit and Amjad Farooq Alvi, it was the first 
PC virus boot sector to hit Microsoft running computers then other popular operating system 
MS-DOS 
 

If your system has fallen victim to a computer virus then there may be a number of symptoms you might 
be experiencing: 

1. Slow computer performance 
2. Erratic computer behaviour 
3. Unexplained data loss 
4. Frequent computer crashes 

TYPES OF VIRUS 

1. Boot Sector Virus- Boot sector viruses are one of the oldest forms of computer virus out there. 
They infect the boot sector or partition table of a hard drive so that they're initiated the 
moment the computer is switched on. 
A Boot Sector virus isn't a specific virus, it's a particular way in which viruses can affect your 
computer. A boot sector is a physical sector on your hard drive which is required to start the 
boot process and load your operating system.  

By placing a virus here, it means the virus is activated every time you start your computer, even before 
your operating system begins to boot up. Often, you won't even realize it's happening which makes the 
threat potentially even worse. Boot sector viruses can even spread to other hard drives you have installed 
or physical media you have plugged into your system. 

Examples- Elk cloner, Brain etc. 

 

2. Direct Action Virus 

When it comes to these types of viruses, direct action viruses infect your files and are one of the two main 
types of computer virus that does this. It doesn't hide in your computer's memory nor install itself. The 
way it works is through particular file types like .EXE or .COM, which they attach into. 

Once you click on the infected file, it becomes active. It then looks for other files in the infected file's 
location so it can spread more. While it's annoying, it doesn't cripple your system's performance since it 
only makes your files inaccessible. 

You can remove it with a simple anti-virus program, so it's not much of a threat compared to the Boot 
Sector virus. 

3. Resident Virus 
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Like its direct action counterpart, the resident virus is a file infector. But its primary difference from the 
former is that they install themselves on your PC unit. They become even dangerous because they can 
persist even after the primary source of the virus infection gets removed. 

Depending on the virus's programming, it can be difficult to spot it and remove it from your system. It 
depends on whether the resident virus is a fast infector or a slow infector. The former causes damage as 
fast as it can while the latter progresses its damage at a much slower pace. 

4. Multipartite Virus 

More nefarious than most viruses, multipartite viruses are an amalgamation of the different types of 
computer viruses regarding how it spreads. It spreads using various means, and it could take a wide variety 
of actions depending on several factors. For example, it can act in a different manner depending on your 
PC's operating system. 

It can infect your boot sector and executable files, making it act and spread faster. This makes it tougher to 
remove and might require a complete reformat to prevent a recurrence. 

Example – Ghostball, Tequila, Ywinz etc. 

5. Polymorphic Virus 

These are complex file infectors that can create modified version of itself to avoid detection. This type of 
virus is dangerous because anti-virus programs have a hard time detecting it. Most programs take days or 
months formulating routines necessary to identify a single polymorphic virus. 

Detection takes a long time because of the way anti-virus programs function. These software types can 
only blacklist a single virus variant. Polymorphic viruses take advantage of this by changing its signature 
when it reproduces, making it look like a different, otherwise harmless file. 

6. Overwrite Virus 

An overwriting virus is a malicious program which, after infection, will effectively destroy the original 
program code, typically by overwriting data in the system's memory. 

7. Spacefiller Virus 

A spacefiller virus also called cavity virus or Chernobyl virus or CIH is a rare type of computer virus that 
attempts to install itself by filling in empty sections of a file. By only using empty sections of a file, the virus 
can infect a file without changing the size of the file, making it more difficult to detect. 

8. Memory Resident Virus 

It is a malicious code that installs in the memory and then infects future programs. Also known as the 
Terminate and Stay Resident (TSR), it finds a way to load in the computer’s RAM and then infects the 
executable files that are opened by the user when a certain conditions are met. A few examples of this 
kind of virus are Jerusalem Virus, Onehalf virus, Magistr, Junkie, Satanbug etc. 

9. Web Scripting Virus 
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These viruses often transmit themselves into your computer's system through the programming used for 
websites. Placing images, videos, and layouts require a certain degree of coding. That means you might 
download the viruses without your knowledge if you click on malicious websites' links or watch their 
videos. 

The best way to prevent this is to have security programs that detect malicious coding when browsing the 
internet. 

10. Browser Hijacker 

This type of virus is one of the most straightforward and easy-to-detect viruses. It will interfere with your 
work by leading you off to different websites even if you enter the internet address you want to go to. A 
good practice is to be careful with your downloads and toolbars. 

11. Macro Virus 

In computing terminology, a macro virus is a virus that is written in a macro language: a programming 
language which is embedded inside a software application (e.g., word processors and spreadsheet 
applications). Some applications, such as Microsoft Office, Excel, PowerPoint allow macro programs to be 
embedded in documents such that the macros are run automatically when the document is opened, and 
this provides a distinct mechanism by which malicious computer instructions can spread. This is one 
reason it can be dangerous to open unexpected attachments in e-mails. Many antivirus programs can 
detect macro viruses; however, the macro virus' behavior can still be difficult to detect. 

OTHER IMPORTANT TERMS 

 Worms 

Worms are spread via software vulnerabilities or phishing attacks. Once a worm has installed itself into 
your computer’s memory, it starts to infect the whole machine and in some case your whole network. 
Depending on the type of worm and your security measures, they can do serious damage. These parasitic 
nasties can- 

 Modify and delete files 
 Inject malicious software onto computers 
 Replicate themselves over and over to deplete system resources 
 Steal your data 
 Install a convenient backdoor for hackers 
 They can infect large numbers of computers fast, consuming bandwidth and overloading your 

web server as they go. 
 Examples: Bagle, I love you, Morrie, Nimada etc. 

 

 Trojan Horses 

Just as it sounds, a Trojan Horse is a malicious program that disguises itself as a legitimate file. Because it 
looks trustworthy, users download it and… hey presto, in storms the enemy. 

Trojans themselves are a doorway. Unlike a worm, they need a host to work. Once you’ve got the Trojan 
on your device, hackers can use it to… 

 Delete, modify and capture data 
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 Harvest your device as part of a botnet 
 Spy on your device 
 Gain access to your network 
 Examples- Beast, zero access, Root kit , Sub7.zeus etc. 

 

 Ransomware 

Ransomware denies or restricts access to your own files. Then it demands payment (usually with crypto-
currencies) in return for letting you back in. 

In May 2017, a ransomware attack spread across 150 countries and compromised over 200k computers 
within just one day. Aptly named WannaCry, the attack caused damage estimated in the hundreds of 
millions to billions of dollars. 

WannaCry affected MS Operating systems that did not have the latest patch installed for a known 
vulnerability. To reduce the risk of ransomware attacks… 

 Always keep your Operating System up to date 

 Keep your Anti-Virus software up to date 

 Back-up your most important files 

 Don’t open attachments from unknown sources (WannaCry was spread via a .js attachment) 

Examples- WannaCry ransomeware, locky ransomeware, bad Rabbit etc. 

 Adware & Scams 

Adware is one of the better-known types of malware. It serves pop-ups and display ads that often have no 
relevance to you. 

Some users will put up with certain types of adware in return for free software (games for example). But 
not all adware is equal. At best, it’s annoying and slows down your machine. At worst, the ads link to sites 
where malicious downloads await unsuspecting users. Adware can also deliver Spyware and is often easily 
hacked, making devices that have it installed a soft target for hackers, phishers and scammers. 

 Spyware 

Spyware secretly records your online activity, harvesting your data and collecting personal information 
such as usernames, passwords and surfing habits. 

Spyware is a common threat, usually distributed as freeware or shareware that has an appealing function 
on the front end with a covert mission running in the background that you might never notice. It’s often 
used to carry out identity theft and credit card fraud. 

Once on your computer, spyware relays your data to advertisers or cyber criminals. Some spyware installs 
additional malware that make changes to your settings. 

Examples- Zango, Zlob Trojan, Keyloggers etc. 

 Spam & Phishing 
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Phishing is a type of social engineering attack, rather than a type of malware. But is a common method of 
cyber attack. Phishing is successful since the emails sent, text messages and web links created look like 
they’re from trusted sources. They’re sent by criminals to fraudulently acquire personal and financial 
information. 

Some are highly sophisticated and can fool even your most savvy users. Especially in cases where a known 
contact’s email account has been compromised and it appears you’re getting an instruction from your 
boss or IT colleagues. Others are less sophisticated and simply spam as many emails as they can with a 
message about ‘checking your bank account details’. 

• Spoofing: Spoofing is when someone or something pretends to be something else in an attempt 
to gain our confidence, get access to a system, steal data, or spread malware. 

• Hacking : The process of attempting to gain or successfully gaining, unauthorized access to 
computer resource.”  

• Cracking : The act of breaking into a computer system, often on a network maliciously, for 
personal gain.” 

• Rootkits : A rootkit is a type of malicioussoftware that is activated each time your system boots 
up. Rootkits are difficult to detect because they are activated before your system’s Operating 
System has completely booted up. A rootkit often allows the installation of hidden files, 
processes, hidden user accounts, and more in the systems OS. Rootkits are able to intercept data 
from terminals, network connections, and the keyboard 

Solutions to Computer Security Threats 

ANTIVIRUS 

Antivirus software helps protect your computer against malware and cybercriminals. Antivirus software 
looks at data — web pages, files, software, applications — traveling over the network to your devices. It 
searches for known threats and monitors the behavior of all programs, flagging suspicious behavior. It 
seeks to block or remove malware as quickly as possible. 

Antivirus software provides protection against these types of threats by performing key tasks: 

 Pinpointing specific files for the detection of malicious software 

 Scheduling automatic scans  

 Scanning either one file or your entire computer at your discretion 

 Deleting malicious codes and software 

 Confirming the safety of your computer and other devices 

Some of the best antivirus programs available right now include the following: 

 Norton 

 Avast 

 McAfree 

 AVG 

 Quick Heal 

 Panda 

 Trend Micro 

 BullGuard 

 Bitdefender 

 Symantec 
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 Kaspersky 

 K7 

FIREWALL: 

A firewall is a network security device that monitors incoming and outgoing network traffic and permits or 
blocks data packets based on a set of security rules. Its purpose is to establish a barrier between your 
internal network and incoming traffic from external sources (such as the internet) in order to block 
malicious traffic like viruses and hackers. It can be either software based or Hardware based. 

 

 

Scan Internet Downloads – 

Ensure that all files downloaded from the Internet are scanned for computer viruses before being used. 
Ideally this scanning should be done from one central point on the network to ensure that all files are 
properly scanned. 

Password – 

A password is an unspaced sequence of characters used to determine that a computer user requesting 
access to a computer system is really that particular user. 

• Strong password : Term used to describe a password that is an effective password that would 
be difficult to break. Often a strong password has between six and ten characters (the more the 
better), numbers, other characters, and both upper and lowercase characters. Below is an 
example of a strong password. 

• Weak password : A password that is not an effective password because it’s easy to remember. 
Names, birth dates, phone numbers, and easily guessable words are considered weak 
passwords. Below is an example of a weak password. 

Digital Signature – 

Alternatively referred to as digitally signed, a digital signature is a mathematical scheme used to verify the 
authenticity of a digital document or message. They are used when determining authenticity and avoiding 
tampering are important, such as in financial transactions. 

Digital signatures are often used as a means to implement electronic signatures that are encrypted which 
allows for both authentication and non-repudiation (the signer cannot deny signing a document while 
claiming his/her private key has not been compromised). 
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PRACTICE QUESTIONS 

1. ____________ was a boot-sector virus 
designed to infect Apple II computers. 

1. Brain 
2. Elk Cloner 
3. Direct Action Virus 
4. None of these. 

2. A virus that is written in a macro language 
and embedded inside  software applications 
like word processors and spreadsheet 
applications is called as _________ 

1. Macro Virus 
2. Browser Hijacker 
3. Web Scripting Virus 
4. Memory Resident Virus 

3. Which malware attack spread across 150 
countries and compromised over 200k 
computers within just one day? 

1. I Love you 
2. WannaCry 
3. Root kit 
4. Beast 

4. Which of the following is not an antivirus? 

1. Panda 
2. Norton 
3. Symantec 
4. Zango 

5. _______ is the part of malware such as 
worms or viruses which performs the malicious 
action; deleting data, sending spam or 
encrypting data. 
A) Denial of service 
B) Exploits 
C) Scams 
D) Payload 
E) Spamming 

6. The attack that focuses on capturing small 
packets from the network transmitted by other 
computers and reading the data content in 
search of any type of information is ____. 
A) Phishing 
B) Eavesdropping 
C) Scams 
D) Exploits 
E) Denial of service 

7. What is the software called which when get 
downloaded on computer scans your hard drive 
for personal information and your internet 
browsing habits? 
A) Backdoors 
B) Key-logger 
C) Malware 
D) Antiware 
E) Spyware 

8. Which of the following is the type of 
software that has self-replicating software that 
causes damage to files and system? 
A) Viruses 
B) Trojan horses 
C) Bots 
D) Worms 
E) Backdoors 

9. What is the name of first computer virus? 
 
1. The Famous 
2. HARLIE 
3. PARAM 
4. Creepe 

5. None  

10. Delayed payload of some viruses is also 
called as 
 
1. Time 
2. Bomb 
3. Anti-virus 
4. None of the above 
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11. What is “Trend Micro”? 
 
1. It is anti-virus software 
2. It is just a program 
3. It is virus program 
4. None of the above 

12.  __________ means to prove/verify the 
identity of the entity that tries to access the 
system’s resources. 
(a) Entity authentication 
(b) Message authentication 
(c) Password authentication 
(d) All of the above 
(e) None of these 

13. Which of the following is/are threat(s) for 
electronic payment system? 
(a) Trojan horse 
(b) Computer virus 
(c) Computer worms 
(d) All of the above 
(e) None of these 

14. Which of the following describes programs 
that can run independently travel from system 
to system and disrupt computer 
communication? 
(a) Trojans 
(b) Viruses 
(c) Worm 
(d) Droppers 
(e) All of these 

15. Which of the following would most likely 
not be a symptom of a virus? 
(a) Existing program files and icons disappear 
(b) The CD-ROM stops functioning 
(c) The web browser opens to an unusual home 
page 
(d) Odd message or images are displayed on 
the screen 
(e) None of these 

16. Biometric authentication works on the basis 
of  

1. Human characteristics  
2. Passwords  
3. Smart cards  
4. Pin 

17. Hacking refers to ____.  

1. data access without permission  
2. data updation without permission  
3. data deletion without permission  
4. all of the above 

18. Which of the following is the first PC virus 
detected on ARPANET in 1970s? 

1. Michelangelo virus 
2. Brain     
3. Creeper                
4. Carzy. A 

19. The viruses that change their appearance to 
avoid detection are called___. 

1. MBR viruses                      
2. DBR viruses 
3. Parasitic viruses               
4. Polymorphic viruses 

20. Which of the following actions is performed 
by an antivirus software on a virus infected file? 

1. Repairs the infected file     
2. Deletes the infected file 
3. Quarantines the infected file 
4. All the above 

21.  _____________ is also known as cavity 
virus. 

1. Polymorphic Virus 
2. Space-filler Virus 
3. Overwrite Virus 
4. Non-resident virus 

22. ______viruses infect executable program 
files: 

1. File Infector Viruses 
2. Macro Viruses 
3. Multi Partite Viruses 
4. None of These 

23. Computer Security Day on 
__________reminds us to protect our 
computers.  
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1. November 30th 
2. November 20th 
3. November 22th 
4. November 10th 

24. World Computer Literacy Day was launched 
by Indian computer company NIIT to mark its 
20th anniversary in 2001 and It occurs annually 
on________. 

1. 4 December 
2. 2 December 
3. 10 December 
4. 22 December 

 

 

 

 

 

 

 

 

 

 

 

Answer key 

1. 2 
2. 1 
3. 2 
4. 4 
5. 5 
6. 2 
7. 5 
8. 4 
9. 4 
10. 2 
11. 1 
12. 2 
13. 4 
14. 3 
15. 2 
16. 1 
17. 4 
18. 3 
19. 4 
20. 1 
21. 2 
22. 1 
23. 1 
24. 2 
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What is information technology? 

Information technology is the technology used to store, manipulate, distribute or create information.  All these 

can be summed up easily – It’s having knowledge, and knowledge comes from having information. Gaining 

knowledge through information is the role of ‘’information technology’’ IT in today’s informed world. 

IT is a set of tools that can help provide the right people with the right information at the right time.  Though IT 

is not a solution to every thing, for IT to work, people must learn how to use it. So you can not assume that IT 

will work for you to share information across the organization when people in the organization don’t know 

how to use it. 

Definition of e-Governance 

Electronic governance or e-governance implies government functioning with the application of ICT 

(Information and Communications Technology). Hence e-Governance is basically a move towards SMART 

governance implying: simple, moral, accountable, responsive and transparent governance. 

What is SMART Governance? 

 Simple — implies simplification of rules and regulations of the government and avoiding complex 

processes with the application of ICTs and therefore, providing a user-friendly government. 

 Moral — meaning the emergence of a new system in the administrative and political machinery 

with technology interventions to improve the efficiency of various government agencies. 

 Accountable — develop effective information management systems and other performance 

measurement mechanisms to ensure the accountability of public service functionaries. 

 Responsive — Speed up processes by streamlining them, hence making the system more 

responsive. 

 Transparent — providing information in the public domain like websites or various portals hence 

making functions and processes of the government transparent. 

Interactions/ Types in e-Governance 

There are 4 kinds of interactions in e-governance, namely: 

1. G2C (Government to Citizens) — Interaction between the government and the citizens. 

 This enables citizens to benefit from the efficient delivery of a large range of public services. 

 Expands the accessibility and availability of government services and also improves the quality of 

services 

 The primary aim is to make the government citizen-friendly. 

2. G2B (Government to Business): 

 It enables the business community to interact with the government by using e-governance tools. 
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 The objective is to cut red-tapism which will save time and reduce operational costs. This will also 

create a more transparent business environment when dealing with the government. 

 The G2B initiatives help in services such as licensing, procurement, permits and revenue collection. 

3. G2G (Government to Government) 

 Enables seamless interaction between various government entities. 

 This kind of interaction can be between various departments and agencies within government or 

between two governments like the union and state governments or between state governments. 

 The primary aim is to increase efficiency, performance and output. 

 Read about government to government initiatives in the linked article. 

4. G2E (Government to Employees) 

 This kind of interaction is between the government and its employees. 

 ICT tools help in making these interactions fast and efficient and thus increases the satisfaction 

levels of employees. 

Some Initiatives in the same field 

Government to Citizen (G2C) Initiatives: 

 Computerization of Land Records: In collaboration with NIC. Ensuring that landowners get 

computerized copies of ownership, crop and tenancy and updated copies of Records of Rights (RoRs) on 

demand. 

 Bhoomi Project: Online delivery of Land Records. Self-sustainable e-Governance project for the 

computerized delivery of 20 million rural land records to 6.7 million farmers through 177 Government-

owned kiosks in the State of Karnataka 

 Gyandoot: It is an Intranet-based Government to Citizen (G2C) service delivery initiative. It was 

initiated in the Dhar district of Madhya Pradesh in January 2000 with the twin objective of providing 

relevant information to the rural population and acting as an interface between the district 

administration and the people. 

 Lokvani Project in Uttar Pradesh: Lokvani is a public-private partnership project at Sitapur District 

in Uttar Pradesh which was initiated in November, 2004. Its objective is to provide a single window, self-

sustainable e-Governance solution with regard to handling of grievances, land record maintenance and 

providing a mixture of essential services. 

 Project FRIENDS in Kerala: FRIENDS (Fast, Reliable, Instant, Efficient Network for the Disbursement 

of Services) is a Single Window Facility providing citizens the means to pay taxes and other financial 

dues to the State Government.The services are provided through FRIENDS Janasevana Kendrams 

located in the district headquarters. 

 e-Mitra Project in Rajasthan: e-Mitra is an integrated project to facilitate the urban and the rural 

masses with maximum possible services related to different state government departments through 

Lokmitra-Janmitra Centers/Kiosks. 

 e-Seva (Andhra Pradesh): This project is designed to provide ‘Government to Citizen’ and ‘e-

Business to Citizen’ services. The highlight of the eSeva project is that all the services are delivered 
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online to consumers /citizens by connecting them to the respective government departments and 

providing online information at the point of service delivery. 

 Admission to Professional Colleges – Common Entrance Test (CET): With the rapid growth in the 

demand as well as supply of professional education, the process of admission to these institutions 

became a major challenge in the early 1990s. Recourse was then taken to ICT to make the process of 

admission transparent and objective. One of the pioneering efforts was made by Karnataka. The State 

Government decided to conduct a common entrance test based on which admission to different 

colleges and disciplines was made. 

Government to Business (G2B) Initiatives: 

 e-Procurement Project in Andhra Pradesh and Gujarat: To reduce the time and cost of doing 

business for both vendors and government. 

 MCA 21: By the Ministry of Corporate Affairs. The project aims at providing easy and secure online 

access to all registry related services provided by the Union Ministry of Corporate Affairs to corporates 

and other stakeholders at any time and in a manner that best suits them. 

Government to Government (G2G) Initiatives: 

 Khajane Project in Karnataka: It is a comprehensive online treasury computerization project of the 

Government of Karnataka. The project has resulted in the computerization of the entire treasury 

related activities of the State Government and the system has the ability to track every activity right 

from the approval of the State Budget to the point of rendering accounts to the government. 

 SmartGov (Andhra Pradesh): SmartGov has been developed to streamline operations, enhance 

efficiency through workflow automation and knowledge management for implementation in the 

Andhra Pradesh Secretariat. 

Central government initiatives as mission mode projects (MMP) 

e-office- The Government of India has recognized the need to modernize the Central Government offices 

through the introduction of Information and Communications Technology. e-Office is aimed at increasing the 

usage of work flow and rule based file routing, quick search and retrieval of files and office orders, digital 

signatures for authentication, forms and reporting components. 

Immigration, Visa and Foreigner’s Registration & Tracking (IVFRT)- India has emerged as a key tourist 

destination, besides being a major business and service hub. Immigration Check Post is the first point of 

contact that generates public and popular perception about the country, thus necessitating a state of the art 

system for prompt and user-friendly services. 

UID- The unique identification project was conceived as an initiative that would provide identification for each 

resident across the country and would be used primarily as the basis for efficient delivery of welfare services. It 

would also act as a tool for effective monitoring of various programs and schemes of the government. 
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Pensions- The pensions MMP is primarily aimed at making the pension/ retirement related information, 

services and grievances handling mechanism accessible online to the needy pensioners, through a combination 

of interactive and non-interactive components, and thus, help bridge the gap between the pensioners and the 

government. 

Banking- The Banking MMP is yet another step towards improving operational efficiency and reducing the 

delays and efforts involved in handling and settling transactions. The MMP which is being implemented by the 

banking industry aims at streamlining various e-services initiatives undertaken by individual banks. 

Implementation is being done by the banks concerned, with the banking Department providing a broad 

framework and guidance. 

Posts- Modernization of Postal Services has been undertaken by the Department of Posts through 

computerization and networking of all post offices using a central server-based system, and setting up of 

computerized registration centers (CRCs). 

State Mission Mode projects 

e-Governance in Municipalities 

It is a unique initiative of the Government of India conceptualized under the umbrella of the overall National e-

Governance Plan (NeGP) and the Jawaharlal Nehru National Urban Renewal Mission (Jnnurm) aimed at 

improving operational efficiencies within Urban Local Bodies (ULBs). 

Crime and Criminal Tracking Network & Systems 

Crime and Criminal Tracking Network & Systems (CCTNS) MMP aims at creating a comprehensive and 

integrated system for enhancing the efficiency and effective policing at all levels and especially at the Police 

Station level through adoption of principles of e-Governance, and creation of a nationwide networked 

infrastructure for evolution of IT-enabled state-of-the-art tracking system. 

Public Distribution System 

Computerization of the PDS is envisaged as an end-to-end project covering key functional areas such as supply 

chain management including allocation and utilization reporting, storage and movement of food grains, 

grievance redressal and transparency portal, digitization of beneficiary database, Fair Price Shop automation, 

etc. 

Health 

ICT for programme management has been undertaken by the Ministry of Health & Family Welfare in the 

Mother and Child Tracking System (MCTS) programme and the Ministry envisages a more comprehensive use 

of ICT including for Hospital Information Systems, supply chain management for drugs and vaccines, providing 
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ICT tools to ASHA and ANM workers, programme management of National Rural Health Mission (NRHM), etc 

through this MMP. 

e-panchayat 

The Panchayati Raj Institutions (PRIs) are saddled with the problems of inadequate physical and financial 

resources, technical capabilities and extremely limited computerization. As a result, the potential of PRIs as the 

preferred delivery channel for the schemes of State and Centre as well as for citizen services has not been fully 

realized. While some computerization efforts for PRIs have been made by NIC over the years, the e-

Governance revolution sweeping the country has not touched the PRIs yet in significant measure. The Ministry 

of Panchayati Raj, Government of India has therefore decided to take up the computerization of PRIs on a 

mission mode basis. 

e-District 

e-District is one of the 31 Mission Mode Projects under National e Governance Plan (NeGP) with the DIT, GoI 

being the nodal ministry. This project aims at providing support to the basic administrative unit i.e. District 

Administration by undertaking backend computerization to enable electronic delivery of high volume citizen 

centric government services which would optimally leverage and utilize the three infrastructure pillars of State 

Wide Area Networks (SWAN), State Data Centers (SDC) and Common Service Centers (CSCs) to deliver services 

to the citizen at his doorsteps. 

Recent Initiatives 

Direct Cash transfer 

To facilitate disbursements of Government entitlements like NREGA, Social Security pension, Handicapped Old 

Age Pension etc. of any Central or State Government bodies, using Aadhaar and authentication thereof as 

supported by UIDAI. 

Aadhar Enabled Payment system (AEPS) : 

AEPS is a bank led model which allows online interoperable financial inclusion transaction through the 

Business correspondent of any bank using the Aadhaar authentication. This has helped in financial inclusion. 

The four Aadhaar enabled basic types of banking transactions are as follows:- 

 Balance Enquiry 

 Cash Withdrawal 

 Cash Deposit 

 Aadhaar to Aadhaar Funds Transfer 

Digital India program 
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This programme has been envisaged by Department of Electronics and Information Technology (DeitY). The 

vision of Digital India aims to transform the country into a digitally empowered society and knowledge 

economy.  The programme will be implemented in phases from the current year till 2018. 

MyGov citizen portal 

Prime Minister  launched an online platform mygov.nic.in to engage citizens in the task of “good governance” ( 

surajya ) as he completed 60 days in office on Saturday. MyGov is a technology-driven platform that would 

provide people with the opportunity to contribute towards good governance. 

E-Kranti scheme 

This is project for linking the internet with remote villages in the country. This scheme will broaden the reach 

of internet services to the rural areas in the country. The fundamental features of this scheme will be making 

the records handy to the government with ease. It also includes Expansion of internet and commencement of 

IT-based jobs in rural areas. It will also boost the use of mobile phones and computers in rural areas. It will also 

expand the use of IT in agriculture and retail trade too. 

Digital Cloud for every Indian 

Certificates issued by the government — education, residential, medical records, birth certificates, etc. — are 

to be stored in individual ‘digital lockers’ and a communication protocol established for government 

departments to access them without physically having to see the hard copy. The purpose of government is 

that copies of certificates issued by the government itself not to be carried around by people to government 

offices for various services. 

M-governance 

M-Governance is not a replacement for e-Governance, rather it complements e- Governance. M-Governance, 

is the use of mobile or wireless to improve Governance service and information “anytime, anywhere”. Mobile 

applications also rely on good back office ICT infrastructure and work processes. It has potential of using 

mobile phones as input devices in certain areas where last mile connectivity becomes issues for simple data 

inputs of critical importance for decision making in government departments. 

M-Governance is not a new concept. The private sector has been greatly leveraging these of mobile phones for 

delivery of value added services for the following which however are mostly SMS based: Banking, Media, 

Airlines, Telecom, Entertainment, News, Sports, Astrology, and Movie Tickets Etc. 

M-governance has increased the productivity of public service personnel, improving the delivery of 

government information and services, increasing channels for public interactions and Lower costs leading to 

higher participation of people. 
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Government initiatives for m-governance 

Mobile Seva 

It aims to provide government services to the people through mobile phones and tablets. It has been 

developed as the core infrastructure for enabling the availability of public services through mobile devices. 

Mobile Seva enables the integration of the mobile platform with the common e-Governance infrastructure 

consisting of State Data Centers (SDCs), State Wide Area Networks (SWANs), State and National Service 

Delivery Gateways (SSDGs/NSDG). 

It enables a government department to integrate both web and mobile based services seamlessly and 

enhances the access to electronic services tremendously leveraging the very high penetration of mobile 

phones, especially in rural areas 

A Mobile Applications Store (m-App Store) has also been developed by DeitY as part of Mobile Seva. The 

Mobile Governance Portal and the m-App Store can be accessed at http://mgov.gov.in/. The m-Appstore 

currently hosts over 240 live mobile applications. The live applications can be downloaded and installed free of 

cost on a mobile phone by any person. 

The project, “mobile seva” has won the second prize at the prestigious United Nations’ Public Services Awards 

in the category “Promoting Whole of Government Approaches in the Information Age” for Asia Pacific. 

Advantages of e-governance 

Following are the advantages of E-Governance 

 Speed: Technology makes communication speedier. Internet, Phones, Cell Phones have reduced the 

time taken in normal communication. 

 Cost Reduction: Most of the Government expenditure is appropriated towards the cost of 

stationary. Paper-based communication needs lots of stationary, printers, computers, etc. which 

calls for continuous heavy expenditure. Internet and Phones makes communication cheaper saving 

valuable money for the Government. 

 Transparency: Use of ICT makes governing profess transparent. All the information of the 

Government would be made available on the internet. The citizens can see the information 

whenever they want to see. But this is only possible when every piece of information of the 

Government is uploaded on the internet and is available for the public to peruse. Current governing 

process leaves many ways to conceal the information from all the people. ICT helps make the 

information available online eliminating all the possibilities of concealing of information. 

 Accountability: Once the governing process is made transparent the Government is automatically 

made accountable. Accountability is answerability of the Government to the people. It is the 
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answerability for the deeds of the Government. An accountable Government is a responsible 

Government. 

 Convenience: E-Government brings public services to citizens on their schedule and their venue. 

 Improved Customer Service: E-Government allows to redeploy resources from back-end processing 

to the front line of customer service. 

 Increased access to information: E-Government improves the accessibility of government 

information to citizens allowing it become an important resource in the making the decisions that 

affect daily life and so it helps in empowerment of citizens 

 


